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Congratulations on your purchase of SuperConvert! Be sure to complete
and return the postage-paid registration card so we can notify you about
other new products and updates to this product as they become available.
Read this manual to learn all about using SuperConvert to its fullest The
manual is divided into three main sections:
The Getting Started section guides you through one-time steps,
including making a working copy of SuperConvert.
The Guided Tour section teaches you how to use SuperConvert in
easy steps.
The Reference section contains detailed information about
SuperConvert.
In addition, the Appendices section contains "Tips and Suggestions" and
documentation for "Out To Launch," a simple program launcher that's
included free with SuperConvert.
Enjoy!
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We don't believe in copy protection - all it does is impair the honest user's
ability to use software to its fullest. We strive to provide high quality
products at reasonable prices. We hope you will support our efforts by
not allowing your family or friends to copy this software.

_....,

Postage-Paid Registration
Be sure to complete and return the postage-paid registration card so we
can notify you as new versions of this program become available.
Updates are always reasonably priced.
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Questions and Comm ents
We always welcome feedback-if you have any questions, or suggestions
for improving this product, p lease let us know. In addition, we would like
to hear your ideas for new programs.

Contacting Us
For orders and product information call (800) 627-3836 or (904) 575-0566
from 9 a.m. to 5 p.m. ET, Monday-Friday.

For answers to technical questions about a specific
product call (904) 576-9415 from 11 a.m.. to 5 p.m. ET,
Monday -Friday.
Contact us electronically for fastest written communica tion:
America Online, AppleLink, GEnie: SevenHills
CompuServe: 72437,3165

FAX: (904) 575-2015
To contact us the "old-fashioned way," write to:
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Seven Hills Software
2310 Oxford Road
Tallahassee, FL 32304-3930
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About SuperConvert
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SuperConvert™ is the link between your JIGS and virtually any graphic!
With it you can convert graphics from Apple II's, Macintosh, IBM, Atari ST,
Amiga, Commodore
64/128, and computer-independent
formats.
SuperConvert also includes several "extra" features : generate "font
sample" pages, "font key" charts, print posters, and make any image
appear as your "desktop background ."
SuperConvert was written by Jason Harper. Since the first release of
SHRConvert in 1987, Jason has been continually improv ing his graphics
conversion program. SuperConvert is the result of his hard work and
dedication to the Apple IIGS community.
Our goal was to make SuperConvert a very useful tool and to make it
valuable to you per sonally. By making a quality program available at a
reasonable price and by not copy-protecting the disk, we think we have
succeeded. We hope that you support our efforts and encourage future
updates and products by not allowing your family or friends to copy
SuperConvert. To borrow a phra se, "Just say no."
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This manual and the software (computer program) described in it are
copyrighted with all rights reserved. No part of the SuperConvert software
or documentation may be reproduced, stored in a retrieval system, or
transmitted, in any form or by any means, mechanical , photocopying,
recording or otherwise, without the prior written permission of Seven Hills
Software Corporation.
You may not distribute copies of this program to others or electronically
transfer this program from one computer to another over a network. This
program contains trade secrets and in order to protect them you may not
decompile, reverse engineer, disassemble, or otherwise reduce this
program to a human-perceivable form. You may not modify, adapt,
translate, rent , lease, loan, resell for profit, distribute, network, or create
derivative works based upon this program or any part thereof.
Apple, IIGS, GS and GS/OS are trademarks of Apple Computer, Inc.
The Graphics Interchange Format is a copyright of CompuServe, Inc.
GIF is a service mark of CompuServe, Inc.
SuperConvert © 1987-91 Jason Harp er
SuperConvert is a trademark of Seven Hills Software Corporation
All rights reserved
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\Y/eknow you are anxious to start using SuperConvert, but please read lhis
section first because it leads you lhrough severa l important steps which
you need to do only once:
• Learning conventions and terminology
• Getting your IIGS ready to start a IIGS-specific program
• Making a working copy of SuperConvert
After completing the GettingStarted section, you will use the Guided Tour.
It teaches you about SuperConvert by showing you how to use severa l of
its features.
Following the tour is the Reference section, which covers every aspect of
SuperConvert.
It is the best place to look when you need added
information or he lp with a particular feature .
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Things You Need To Know
Requirements

rI

To use SuperConvert you need:
• An Apple IIGS with at least 1MBof memory
• One 3.5" disk drive
• SuperConvert includes GS/OS-the "disk operating system." GS/OS
requires internal ROM version of at least 01-wh en you turn on the
computer, if the bottom of the screen does not show a version
number, contact your authorized Apple dealer for an upgrade.
• To print, you need any printer that works with a standard IIGS printer
driver. Included are printer drivers for the Apple ImageWriter I, II,
and LQ, and Epson FX-compatible printers. If you wish to print to a
LaserWriter, we assume you have the appropriate printer drivers
available to you. If you wish to print to a Hewlett-Packard DeskJet or
LaserJet, you can purchase and use the Independence printer driver
package from Seven Hills Software.
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Keys on Your Keyboard
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Keys on the keyboa rd are referred to by the name printed on them
(Delete, Option, A, etc.). The Command key is shown as 0 .
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Steps
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Steps you should follow are indented and numbered. For example:
1. Use SuperConvert
2. Convert virtually any graphic to your JIGS!
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Mouse Terms
This manual uses four terms to describe the different ways you can use
the mouse:
Clicking means quickly pushing down and releasing the mouse button
while the mouse remains motionless. One use of clicking is to select a
command.
Double-Clicking
means quickly clicking twice . Double-clicking
is
commonly used as a shortcut for some action. For example, doubleclicking on a folder opens that folder.
Pressing
means holding the mouse button down while the mouse
remains motionless. The most common use is pressing on a scroll bar 's
arrow to cause the document to scroll until the mouse button is released.
Dragging means holding the mouse button down, moving the mouse to a
new position and finally releasing the mouse button. Common us es are
choosing a menu item and moving or resizing a window.
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There are several things you must do in order to use any software that is
written specifically for the Apple JIGS. These settings are common so it is
likely that you r IIGS is already prepared to run SuperConve rt.

Control Panel Settings
The first step is connecting the mouse, then using the Control Panel to
correctly set various op tions:
1. While the computer is off, plug the mouse into your keyboard.
2. Turn the mon itor on.
3. Hold down the Option key while yo u turn on the computer's
power switch .
4. When you see several choices on the screen, release the Option
key.

5. Press 1 to enter the Control Panel.

Slot Settings
Enter the Slots display:
1. Press the Up Arrow unti l Slots is highlighted, then press Return.

Slot 4: Make sure that Slot 4 indicates you are using the Mouse Port:
2. Press Down Arrow un til Slot 4 is highlighted .
3. If Slot 4 reads Your Card, press Right Arrow to change the option
to read Mouse Port.
Startup Slot: If you choose, yo u can tell the IIGS to sta rt loading
programs from the 3.5" disk drive:
4. Press Down Arrow unt il Startup Slot is highlighted.
5. Press Right Arrow until the desired slot number appears (if you
have the 3.5" disk connected to the back of the IIGS, the number
is 5).
Save the Slot Settings:
6. Press Return to save the current settings for the Slots display.

p
'1
Preparing.YourApple IIGS
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RAM Disk Setting
RAM disks use memory that could be used by the program. SuperConvert
need s 1MB memory to operate, so verify that there is at least this much
memory free for it to use:
1. At the Control Panel, press Down Arrow until RAM Disk is
highlighted, then press Return.
2. Press Down Arrow to highlight Maximum RAM Disk Size (or
"Select RAMDisk Size" on the new est IIGS model).
3. As a general rule, IIGS-specific software works better with more
memory available to it. Thus, we suggest setting the RAM Disk
size to 0K. If the Maximum RAM Disk Size nee ds to be reduced,
press Left Arrow until its size is acceptable .
4. Press Return to save the current RAMDisk settings.
5. If you changed the Maximum RAM Disk Size, turn the compute r
off. NOTE: Changes to the RAM Disk display don't take effect until
the computer is turned off (O-Control-Reset does not work; you
must turn the computer off if you changed this setting.). If you
turn the computer off, wait 15 seconds before turning it back on.

Other Settings
This manual assume s that you already have your printer connected and
working with the Apple IIGS. If not, refer to the documentation that came
with your printer to connect it and to set any necessary Contro l Panel
settings.

t
r
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A popular printer configu ration is an Im ageW riter printer directly
connected to the Printer Port on the App le IIGS. For this config urati on,
the contro l panel setting for Slot 1 should be Printer Port and every printer
port setting should have a checkmark beside it.

Check Your NDAs
New Desk Accessories are stored in the System/Desk.Aces folder of you r
startup disk. When you sta rt Sup erConvert eac h New Desk Accessory sets
aside memory for its own us e; memory acquired by a New Desk
Accessory cannot be used by SuperConvert. If you have just 1MB memory
you should consider remov ing any install ed NDAs to give SuperCo nvert
the most memory possible.
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Making Working Copies
Before proceeding, protect the original disks by
making sure that they are write-protected!
Look at the hole in the upper-rig ht corner of
each of the original disks. The disk is writeprotected
if you can see through the hole. If
you can't see through the hole, slide the tab so
you can.
Whenever you purchase software you should make a working copy of
each original disk. NOTE: SuperConvert is not copyprotected,
but it is
copyigbted.
Please do not make copiesfor your f amity orfrien~every
illegal copy you see is a vote against friendly software and for copyprotection and higher prices.
After making your working copies (either
you should store the original disks in a
develops with a working copy another
disk. If a problem ever develops with an
Software for replacement information.

on a hard drive or on 3.5" disks)
safe place so if a problem eve r
can be made from the original
original disk, contact Seven Hills

I
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Installing Onto 3.5" Disks
This section describes installing SuperConvert onto 3.5" disks. If you are
installing SuperConvert onto a hard disk drive, skip to the section titled
"Installing Onto A Hard Disk Drive."

Starting the Computer
1. Insert the disk labeled Startup Disk into the startup disk drive.

2. Turn on the monitor and computer (if the computer is on already,
hold Cl-Control down and press Reset). The 3.5" disk drive will
come on and begin loading our Out To Launch program launcher.
NOTE: If you did not set your 3.5'' disk drive to be the startup slot,
the computer will try to start up from some other disk drive. If you
get the message "Check Startup Device, " hold Control and press
Reset. At the prompt type PR#S (assuming your 3.5'' disk is in slot
5) and press Return.

r
r
r

Initializing Disks

Before proceeding, make sure you can see through
hole in the upper-right corner of the original disks!

the

To make working copies of SuperConvert on 3.5" disks, you nee d two
initialized (but otherwise blank) 3.5" disks.
To initialize the disks we'll use the Disk Initializer desk accessory. Disk
Initializer is provided free with SuperConvert, and can be used with othe r
GS-specific programs that support NDAs.

l'l
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To use Disk Initializer,
1. Choose Disk Initializer from the • menu (move the p oi nter ove r
the • (App le) menu, press and ho ld dow n the mouse butt on,
drag down to h igh light Disk Initializer, then release the mouse
but ton).
The following dia log box appea rs:

DiskInitializer v1.1
CopHright 1989,91bySevenHill s Software
Corp
.
Writtenb11Steve Stephenso
n

rl■l•N

I

Home
the newdisk: ...S_to_r_tu_p
___

( Cancel )

_.

( Initialize]

Disk Initializer dialog box

'1
'1

The scro ll box displays the slots and drives tha t have a 3.5" or 5.25" d isk
drive. To initialize a disk,
2. Click on the slot/drive you want to use for initializ ing (us ually 3.5"
disk dr ives are loca ted in slot 5). NOTE: For the best speed
performance you should initialize the disk in the same slot and
drive that the disk will be used in. For example, if you are
initializing a startup disk then you should initialize the d isk in the
startup disk d1ive. ff you are initializing a data disk then you
should initialize the disk in the data disk drive.
3. Inse rt a blank disk.
4. Type the name for the new disk (the first disk is named "Startup").
The name cannot be longer than 15 characte rs, and it must begin
with a letter and contain only letters, numbers , and periods.
5. Click the Initialize bu tton. NOTE: This button is active only if a
valid disk nam e is entemd.
After you click Initi alize, the disk in the slot and drive you specified is
checked. If the disk is bl ank it will be initialized immed iate ly. If the disk
is not blank you will be asked to confirm you r decision to initialize it.
Neve r initi alize an original disk!

Installing Onto 3.5" Disks
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After the disk is initializ ed it will be ejected and you will be told whether
the initialization was successful. If initialization fails for a disk, discard
that disk and u se another one. If initialization was successful, apply a disk
label and write the appropriate nam e on it.
Repeat steps 2-5 to create one disk with each of the following names :

QI Startup

0

(done in step 4)

Program

After you have initialized and appli ed a label to the two disks, click Cancel
to return to the Out To Launch window.

Copying the Original Disks

Before proceeding, make sure you can see through the
hol,e in the upper-right corner of the original disks!
App le's "Finder" is a program that lets you do "hou sekeeping" tasks, such
as copy ing disks and deleting files. We'll use the Finder to make wo rking
co pies of the su ppli ed disks.
1. Click the Laun ch Other button in the Out To Lau nch window.
2. Select "Finder" and click Open.
When the Finder is finished loading , you will see a blue desktop with a
menu bar at the top of the sc ree n, the Startup.Dis k icon at the top-right of
the scree n, and a Trash icon at the bottom-right of the scree n.
Now we'll use Apple's Finder to make an exact copy of each of the
suppli ed disks:
1. Insert the disk you want to copy onto (one of the disks that you
initialized and ha nd-labe led). The first "des tinati on disk " is the
disk h an d -lab e led Startup, so inse rt that disk (if you hav e on ly
one 3.5'' disk drive, yo u w ill h ave to eject the original disk to
make room for it).
2. Insert the disk you want to copy f rom (one of the orig inal disks
sup p lied with SuperCo nve rt). The first "sou rce disk" is the
origina l disk labeled Startup Disk, so insert that disk.
3. Drag the orig in al disk icon onto the hand-labeled disk icon:
Position the arrow pointer over the original disk icon, hold down
the mouse button, drag onto the hand- labe led disk ico n (it turn s
black) then release the mouse butt o n. The first copy is mad e by
dragging the Startup.D isk icon onto the Startup icon.

10
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The Finder asks if you want to replace the contents of the
destination disk with the contents of the source disk. Click OK to
proceed. NOTE: If you get a message stating that the destination
disk is write-protected, you are trying to copy in the wrong
direction-click the Cancel button and go back to step 3, making
sure you drag the source disk icon onto the destination disk icon.

During the copy process the Finder may ask you to insert a particula r disk.
Find the desired disk, insert it and dick OK to continue.
When the Finder is finished copying the disk,
5. Drag the source disk icon onto the Trash icon. Th is ejects the
disk and removes its icon from the desktop.
6. Drag the destination disk icon into the Trash to eject it and
remove its icon from the desktop.
Repeat steps 1-6 for each of the following disks:

Drag:

Onto:

51]Startup.Disk

Startup
Program

D SuperConvert
Removing the Finder

In order to create some extra disk space on your Startup disk, you might
want to remove the Finder:
1. Insert your disk hand-labeled Sta,·tup into a drive.
2 Click on the Startup icon to select it, then choose Open from the
File menu.
3. Drag the Finder icon into the Trash.
4. Drag the Startup icon into the Trash to eject the disk and remove
its icon from the desktop.

'1

NOTE: Disk Access from Seven Hills Software is a great alternative to the
Finder. Disk Access is a new desk accessory (NDA) that lets you do
everything the Finder does, but from within the program you are using.
That means you don't have to quit just to copy, delete, or mname a file!
Disk Access even includes features that the Finder doesn't, including
finding a file by name and showing the contents of any file.

'1
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Quitting the Finder and Shutting Down
Let's quit Apple's Finder and return to Out To Launch:
1. Choose Shut Down from the Special menu.
2. Click to select the "Return to launching application" option.
3. Click the OK button to return to Out To Launch.
4. When Out To Launch appears, choose Shut Down from the File
menu. NOTE: See Appendix B for more information about using
Out To Launch.
Skip to the Guided Tour section to begin using SuperConvert.
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Installing Onto A Hard Disk Drive
Installing SuperConvert on a hard disk drive is just a matter of copying
some files from each of the supplied disks to your hard drive. This
section describes which files to copy and where to put them. To begin,
sta rt up the computer with your hard drive, then launch Apple's Finder.
Because you have a hard drive, we assume yo u are familiar with file
management and using the Finder, so that is not covered in-depth here. If
you n ee d more information about the Finder, refer to the manua ls that
came with your Apple II GS.

Installing SuperConvert
On your hard disk drive, create a folder called SuperC onvert.
Insert the disk lab e led SuperConvert into a drive and ope n it. Select all
the files in the window, then drag th em onto the SuperConve rt folder icon
that is on you r h ard drive.
After the files ha ve been copied, dr ag the SuperConvert disk icon into th e
Trash to eject it and remo ve it from the desktop.
Open the SuperConvert folder, then open the Icons folder. Drag the
SC.Icons file into the main Icons folder on you r hard drive. Finally, drag
the empty Icons folder into the Trash .

'1

'1
Installing Onto A Hard Disk Drive
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Desk Accessories
Desk Accessories are stored in the System/Desk.Aces folder of your hard
drive.

NOTE: SuperConvert bas been tested extensively. If you experience strange
problems with SuperConvert, remove all desk accessories, then add them
back one at a time to see if a particular accessory is causing the problem. If
the problem stilt exists with no accessories installed, please send a report to
Seven Hills' technical support.
We have provided a new desk accessory named "Disk Initializer" that lets
you initialize 3.5" and 5.25" disks from within a program like
Supe rConvert. To install this onto your hard drive, first open the System
folder on your hard drive and locate the Desk.Aces folder. Next, insert the
disk labeled Startup Disk, open the System folder, then open the
Desk.Aces folder on that disk. Finally, drag the Initializer.NDA icon into
the System/Desk.Aces folder on your hard drive.
After you have copied the Disk Initiali ze r, drag the Startup .Disk icon into
the Trash to eject it and remove it from the desktop.
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Guided Tour
The Guided Tour section guides you through sev e ral SuperConvert
features. Complete information about e ach SuperConvert feature can be
found in the Reference section.
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Using SuperConvert
Starting the Program
If you insta lled SuperConver t on a hard drive, sta rt the comp uter then
open the Supe rConvert program.

·1

To begin using the working copy of the 3.5" SuperCon vert disks, follow
these steps now (and whenever you wa nt to start SuperConve rt):
1. Insert the disk hand-labeled Startup into the sta rtup disk drive.
2. Turn on the mon itor and computer (if the computer is on already,
hold CJ-Control down and press Reset). The 3.5" disk drive will
come on and begin loading our Out To Launch program launcher .
NOYE: If you did not set your 3.5'' disk drive to be the startup slot,
the comput er will try to start up Jrom some other disk drive. If you
get the message "Check Startup Device, " hold Control and press
Reset. At the prompt type PR#S (assuming your 3.5" disk is in slot
5) and press Return.
3. When the Out To Launch program appea rs, click th e Launc h
Other button.
4. Insert the d isk hand-label ed Program (if you have only one 3.5''
disk drive you' ll need to eject the Startup disk first).
5. Select Supe rConve rt and click Open.

If you have only on e 3.5'' disk drive you w ill be p rompted to switch disks
as SuperConvert is loading. When you are asked to insert a particular
disk, insert it and click OK.

'1]
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Afte r the pr og ram is lo ad e d , yo u 'll see Su pe rCon ve rt's m e nu b a r at th e top
of the scree n and two of its w ind ows o n th e d es kt op:

et File [dit Scre-e-n
illlooe 1rue-color iS\age-WindowsExtras

Amigo
Com11odore
64/128
Macintosh
IBHPC~compatibles
/ \ Co11puter
type (
nf

Savefomats
( Infoonformat)
$C0,0 PointWorks+
1.0(obsolete)
$C0,1Pack811tes
(obsolete)
$Cl uncompressed
screen
Findericon(newfile)
Load
··

UncompressedSHR
screen($C1,BIM)
Pointworks
Gold640modefiles
PrintShopII gs colorgraphic
PSl !gsbuilt-in (GRRPHIC.CGT0-7)
Findericonfile
*AST
picture data file (coloronl11)
Tbe screen display aft er load ing SuperConvert

Checking the Version Number
To chec k the vers ion nu mber of the Su perCp nvert p rog ram yo u are usin g :
1. Choose About SuperCo nve rt from the • (Apple) me nu .

!ContinueI
SuperConv
ert version3.01
Copuright © 1987-91
JasonHarper
AlI rightsreserved.
Progra
mname is a trode11
ark
of Seven HilIs SoftwareCorp.
2.
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About Sup erConvert dial og box
Wh e n you are d o ne lo ok ing at th e di alog bo x e ith e r clic k
Con tinu e or pr ess Retu rn .
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There are two types of images that SuperConvert works with: screen
images and true color images. Screen images are those that can be
displayed normally on the IIGS screen; true color images are those that
have a greater resolution or color range than the IIGS can normally
display. For this part of the Guided Tour section we will use a screen
image as a basis for our conversions (true color image formats begin with
an asterisk, screen image formats do not).
The graphic we're going to convert originally existed on the Atari ST. We
have already transferred the file to a IIGS disk, but it is not usable because
the file's internal structure is only understood by some Atari programs.
We will use SuperConvert to load and convert this graphic, then save the
final image to disk in a format that will be usable by most IIGS-spec ific
programs.

Loading
To load the graphic:
1. In the Load Formats window we must select the computer and
specific format of the original picture. In this case, first select the
"Atari ST" computer type, then select the specific format of
"Neochrome (.NEO)".
2. Choose Load & Convert from the File menu, or click the Load
button in the Load Formats window, to select the graphic Loload.
3. Open th e Samples folder and se lect the file ca lled
"Big.Gorilla.NEO".
4. Click Accept and the image is loaded, converted, and displayed
on the JIGSscreen.
5. When you are done looking at the image, click the mouse or
press a key on the keyboard to display the main SuperConvert
screen. The loaded screen image appears in a window at the
lower-right of the screen.
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Converting A Screen Image
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Viewing
The graphic can be viewed in a variety of ways by choosing the following
options from the Screen Image menu:
1. Choose View Full Screen to see the full screen graphic.
REMEMBER: When you 're done viewing the graphic, click the
mouse button or press a key on the keyboard to continue.
2. Choose View Half Size to see the graphic at half size. This is very
useful for viewing graphics that are larger than a single screen .
3. Choose View X4 Magnified to expand the image to four times its
actual size. This is useful for viewing details that you might not
otherwise see. Dragging the mouse scro lls the image so you can
see different parts of it. Click the mouse button or press a key on
the keyboard to continue.

r•

r•

Graphic Modes
Let's look at the image another way:
1. Click in the Screen Image window to activate it (the title bar will
dark en, and the close box and zoom box will appear).
2. Click the zoom box to expand the window to be full-screen size .
Yikes! The image that looked fine just a minute ago now looks
awful! Why does this happen, and how can we fix it?

I''

There are two graphic screen modes on the JIGS: 320 mode and 640
mode. There are two basic differences between these modes:
• Resolution: 320 mode provides a screen that is 320 pixels (dots) wide ,
w hile 640 mode provides twice th at many pixels wide (both screens
are 200 lines tall).
• Color Range: 320 mode provides a large "palette" of colors that can
be used for detai led shading and mo re rea listic pictures, while 640
mod e has a very small palette of colors .
When a IIGS-spec ific program is written, a choice is made whether it will
work in 320 mode, 640 mode, or both. This choice is based on what type
o f program it is: Games usually work in 320 mode because highlydetailed, re alistic graphic s are possible. Productivity program s usually
work in 640 mode because more informati o n fits on the screen. Programs
tha t work on ly w ith graphics (such as painting programs and
SuperConvert) usually work with both display modes.

20
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SuperConver t is primarily a 640 mode program (when you see the menu
bar and windows you are in 640 mode). But when a graph ic is loade d
that wou ld look best in 320 mode, SuperCo nvert switches to 320 mode to
display the picture. Then when you click the mouse or press a key on the
keyboard, the program sw itches back to 640 mode.
Because you can switch modes in SuperConvert, the differences between
320 mode and 640 mode don't create a problem. But what happens if you
want to use a 320 mod e picture in a 640 mode program? The result is
similar to wh at happ ene d to the gorilla image ... it looks great in 320 mode
but looks awful in 640 mode .
So what can you do about it? Use SuperConvert , of course!

Remapping
One of the most powerfu l opt ions in Supe rConver t is th e ability to
"remap" an image to use a different d isplay mode and/or color palett e . In
this sectio n we' ll experiment with different remapping options.

A 640 Mode Color Conversion
The screen image current ly is a 320 mode graphic. If we tried using it in a
640 mod e program it would look awful, so we will use SuperConvert to
"remap" it to becom e a 640 mode image. \Y/e might also nee d to change
the palette of colors to match the receiving pro gram's palette.
For this example, we' ll remap the image to the most common se tting for
640 mode: a 640 mode "dithered" image that uses the defa ult pa le tte of
colors. The resulting graphic shou ld be usable in any 640 mode program
that suppo rts graph ics.

,.

Each time you "remap" an image, a new screen image is generated. If
SuperConvert simply rem apped the existi ng screen image into a new
screen image, the original image would be lost from memory.
To avoid re-loading the origina l image from disk every time you wa nt to
try a different remap option, Sup erConve rt always remap s from the true
color image. If the original graphic is just a scree n image, SuperCo nvert
automatica lly crea tes a "true co lor image" the first time a command is
chosen from the True Color Image menu. The true color image remains
unaltered in memory regardless of how many times yo u use the Remap
Image command to gene rate new scree n images.

Using SuperConvert: Converting A Screen Image
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Let's demonstrate :
1. Choose Remap Imag e from the True Color Image menu. There is
a slight delay as SuperConvert transforms the screen image into a
true color image, then the remap options appear:
6rophic■odr
@320 x200,16colors
0 640x200,4 colors
0 640x200dithermode
0 Huitipalette 11odes
Palette t, usr
0 Defaultcolor
0 Grauscale
@Calculated

( Infoontheseoptions)
Distinctcolorsused: 16
Distribution:
full color

Otheroptions
[g] Integralscalingonly
[g] ClipHoriz.
beforeVert.

D Clipto onescreen

Verticalscaling:from200to 200(1:1)
Horizontal:
from320to 320(1:1)

0Stored po!ette

0 Picture'scurrent
() ( Getother... )
Rendering
olgorith■
0 Closestmatch
@Pattern dither
() Errordiffusion

( Cancel)
( Quick
re11ap
)

( Hormal
re11op
)

Remap Image dialog box
A few seconds after this dialog appears , some further information
appears below the "Info On These Options" button.
This
information states that the true color image has 16 distinct colors
and that it is a full color graphic.
Now we just ne ed to specify the options we want for the conversion, and
SuperConvert will remap the true color image into a new screen image :
2. Under Graphic Mode select 640 x 200 dither mode . Most 640
mode prog rams use a special "dithering" technique for simulating
mor e colors on the screen, so it's usually best to use this option
for 640 mode programs.
3. Under Palette To Use select Default Color. In order for the image
to appear properly, the image's color pal ette must match the
program's. While some 640 mode programs can use a custom
pa lette, all should work with the default color palette.
4. Under Rendering Algorithm se lect Pattern Dither. This usually
produc es better results than "closes t match."
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Click the Normal Remap button and a new sc reen image is
generated.
NOTE: While the 640 mode image does not match the original
quality and detail of the 320 mode picture, it is much better than
just displaying the "raw" 320 mode picture on the 640 mode
screen! Also, better conversions are possible ... we just selected the
options above because they should work in any 640 mode
program.

Click the mouse button to go back to the main SuperConve rt scree n, and
notice that the image is identical to the full screen view .

A Better 640 Mode Color Conversion
As mentioned in step 3 of the previous section, some 640 mode programs
can use a custom color palette. By allowing a palette that is more su ited
to a particular picture, the quality of the image can be impr oved.
1. Choose Remap Image from the True Color Image menu. Because
a true color image already exists in memory the dialog appears
sooner.
The choices from the last conversion are still se lected, so we only have to
change one option:
2. Under Palette To Use select Calculated. The Calculated optio n
should be used in programs that can support a custom palette.
This option lets SuperConvert calcu late which colors would be
best for this particular picture.
3. Click Normal Remap and a new screen image is generated. When
the conversion is finished you shou ld see quite an improvement
in the color!
NOTE: When you click the mouse button to return to the main
SuperConvert screen, you will notice that the colors change. The
previous conversion used the default color palette, which matches
SuperConvert's display. This conversion, though, uses a calculated
colorpalette that does not match SuperConvert's.

''-11

This small examp le show s the importance of learning how a particular
program works with graphics. The graphic mode (320 vs. 640) is easier to
deLermine than what kind of color palette the program supports (standard
vs. custom). Some examp les were provided on disk and are discussed
later-they will help you determine what kind of graphics a particu lar
program can support. In the meantime, let's experim e nt with some
different kinds of conversions:

Using SuperConvert: ConvertingA Screen Image
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A 640 Mode Black and White Conversion
Let's create a 640 mode black and white image for use in any 640 mode
program (they sho uld all support black and wh ite).
1. Choose Remap Image from the True Color Image menu.
2. Under Graphic Mode se lect 640 x 200 dither mode.
3. Under Palette To Use click "Get Other ... ". This option presents a
dialog box with severa l choices for 640 mode grap hics:

r
r_

Other 640dither11ode
polettes:
@Black&white only
0 Backwardsdefaultcolors.for flippedimages
0 Grauscale,leavea colorfor editing
(

Ok

)

"Get Other" palette choices for 640 mode grapb ics
4. Select Black & White Only, then click OK.
5. Under Rendering Algorithm, se lect Error Diffusion. If a color
doesn't map exactly to black or white, erro r diffusion will try to
compensate for the difference to produce a better resu lt.
6. Click Normal Remap and the new screen image is created .

Going Gray in 320 Mode
Because the original graphic contains many different colors, and because
320 mode has more color choices than 640 mode, we ca n predict that (for
this particular graphic) a 320 mode conversion will look be uer than a 640
mode conve rsion. Let's see if this is true:
1. Choose Remap Image from the True Color Image menu.
2. Unde r Grap hic Mode select 320 x 200, 16 colors.
3. Unde r Palette To Use select Grayscale. This opt ion w ill cause the
colors in the original graphic to be converted to gray.
4. Unde r Rendering Algorithm select Error Diffusion. If a color
doesn't map exactly to a gray value, error diffusion will try to
compensate for the differe nce, thus producing a better result.
5. Click Normal Remap and the new screen image is cre ated. This
definitely shows wha t a larger color palette can do!
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Saving
If you want to save any of the conversions to test in your favorite IIGSspecific program, select the appropriate Save Format and click Save.
Most JIGS programs support "$C0,2 Apple Preferred" format, which is why
that format is highlighted by default.

'1

Using SuperConvert: Converting A Screen Image

25

Converting A True Color Image
When you load a screen image format, a screen image is automatically
created and displayed. Because a true color image format can support
pictures that have a greater resolution or color range than the IIGS can
normally displa y, a screen image is not created automatically. Instead,
after loading a true color image you are presented with the "Remap
Image" dialog box so you can create a screen image.

Loading
To load the sample true color image:
1. In the Load Formats window, first select the "Atari ST" computer
type, then select the specific format of "•Spectrum 512
Compressed (.SPC)". NO'JE: The asterisk (-J indicates this is a true
color image Load Format.
2 Click Load, then select the "Clown.SPC" graphic in the Samples
folder.
3. Click Accept and the image is loaded, then the Remap Image
dialog box appears.

r
t
r
r
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Viewing
When the Remap Ima ge dialog box appears, wait a few seconds and
further information about the graphic will appear below the "Info On
The se Options" button. It will state that the re are 81 distinct colors, and
that the graphic is a full color image.
There are three ways to view this image. You have already tried one way
(doing a normal remap to create a quality screen image). Two faster ways
are to either view an approximation of the true color image or to generate
a quick "preview" screen image.

!I'
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Let's try each of these methods to see how they differ:
1. Click Cancel to indicate that you don't want to remap the image.
Notice that the Screen Image window does not contain a screen
image (because you clicked Cance l in the Remap Image dialog
box).
2. Choose View Approximation from the True Color Image menu.
This option displays an approximation of the true color image by
separating different color components of the true image into
separate lines on the screen. The result is a magnified view of the
image, but you can get an idea of what the origina l graphic
looked like (you can use the mouse to scroll around the image).
Now let's generate a quick preview screen image:
3. Press OM (ho ld down the Command key (0) and press M). This
is the shortcut for the "Remap Image" command on the True Color
Image menu.
4. According to the information under the "Info On These Options"
button, there are 81 distinct colors in this graphic. Because there
are so many colors, 320 mode will give better res ults than 640
mode, so verify tha t 320 x 200, 16 colors is selected under
Graphic Mode.
5. Click Quick Remap to quickly generate a preview image . While a
norma l remap can take several minut es to comp lete, a quick
remap takes only a few seco nd s. A quick remap ignor es all
options settings other than the chosen Graph ic Mode, and it
converts only up to one scree n (which is fine for getting a quick
preview image).
OK ... we've seen the preview s. Now let's ge nerate a "final" screen image :
6. Press OM to present the Remap Image dialog bo x.
7. The suggested conversion opti ons should be se lected already :
Graphic Mode is 320 x 200, 16 co lor s; Palette To Use is
Calculated; Rendering Algorithm is Pattern Dither.
8. Click Normal Remap and a h igh qu ality screen image is produced
from the true color image .

l~'1
r '1
fi
/

,.

Using SuperConvert: Converting A True Color Image

27

Other Examples
In the Samples folder on the program disk are other examples that have
already been converted with SuperConvert. The samples show the types
of conversions you can do in order to make graphics more compatible
with the software you use, while maintaining as much quality as possible.
To view the samples that are discussed in this section, we recommend that
you remap the original "Clown.SPC" image using the settings that are
mentioned. Alternatively you can use the "Apple IIGS-Specific/SuperHiRes
($C0/PNT, $Cl/PIC)" Load Format to load the variations that have been
saved on disk already.
When remapping the original true color graphic you'll need to set three
options:
• The Graphic Mode is chosen based on which program you intend to
use the graphic with.
• The Palette To Use determines how colors will be converted. This
option is also chosen based on the program you intend to use .
• The Rendering Algorithm does not affect the compatibility of the
image, but it does have a great effect on quality and suitability for
special uses. Different choices are available, depending upon the
selected graphic mode and palette.

320 Mode Conversions

'l

320 mode is typically used in painting programs and games because the
color range makes it possible to provide detailed shading and more "lifelike" images.
For the 320 mode conversions below, select the "320 x 200, 16 color"
Graphic Mode.

File: m320.Color.Calc
Palette:
Rendering:

Calculated
Pattern dither

A calcul ated colo r palett e gives the best color translation. The resulting
graphic is useable in 320 mode programs which recognize non -standard
color pale ttes (e .g. Platinum Paint).
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File: m320.Color .Def
Palette: Default color
Render ing: Pattern dither
Colors are translated to a fixed color palette, so the color choice is not as
good as using a calculated palette. However, it is compatib le with 320
mode programs that use a fixed palette .

File: m320.Grayscale
Palette: Grayscale
Rendering: Error diffusion
The picture maintains its quality because of the many sh ades of gray
available in 320 mode. This graphic looks bes t in 320 mode programs that
recognize non-standard pa lettes .

File: m320.BlackWhite
Palette: Black and White only
Rendering: Error diffu sion
Black and white grap hics are not very good in 320 mode. The lowe r
resolut ion of 320 mode is fine wh en there are many color (or gray) shades
availab le, but if an image has a limited number of co lors the highe r
resolution of 640 mode is a better cho ice.
\ .

640 Mode Conversions

~

640 mode is typica lly used in productivity software because the higher
resolu tion allows more informa tion to fit on the scree n. Most painting
programs also have a 640 mode option.

I '1

File: m640.4color.Def
Graphic Mode: 640 x 200, 4 color
Palette: Default color
Render ing: Pattern dither
Using the 4 color mode creates a screen image that contains on ly four
unique colors. Most 640 mode programs, however, support dithe ring
which allows better color selection .

Using SuperConvert: Other Examples
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File: m640.Dcolor.Def
Graphic Mode : 640 x 200 dither mode
Palette:

Default color

Rendering:

Pattern dither

Using dith er mode allows better color conversion, and by using the default
color pal ette it remains compatible with most 640 mode programs. These
settings are good for AppleWorks GS (AWGS also supports a calculated
color pal eLL
e, but it applies to all imported graphics. If you will only be
using a single graphic in AWGS the use the Calculated palette; if you use
more it is better to convert all the graphics to the same palette).

File: m640.Grayscale
Graphic Mode:

640 x 200 dither mode

Palette: Grayscale
Rendering:

Error diffusion

With only four shades of gray available in 640 mode, the image is not as
good as a 320 mode image which has many shades.

File: m640.BlackWhite
Graphic Mode: 640 x 200 dither mode
Palette:
Rendering:

Black and White only
Error diffusion

For graphics that have very few co lors, 640 mode is the best choice
because its higher resolution allows greater detail than 320 mode .

GraphicWriter Ill Conversions
If you own GraphicWriter III and you import 320 mode graphics you can
use SuperConvert to get higher quality than what you've been using
because GraphicWriter III handl es graphics in a unique way. NOTE: For
640 mode and MacPaint graphics, it is better to import straight into
Graphic Writer III.
The exact steps for creating high quality conversions for GraphicWriter III
are given in Appendix A. Basically, to gain the increa sed resolution we
"pre-double" the height of the image with SuperConvert's fancy algorithms
instead of letting GraphicWr iter III double the height by simply repeating
eac h line of a graphic.
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The examples below were produced by using SuperConvert to double the
height of each image (vertical scaling 2:1). To import these "ultraresolution" examples into GraphicWriter III:
1. Start GraphicWriter III, create a new document, then create a
painting frame.
2. Choose Import from the File menu, select the "Super Hires"
translator, then click OK.
3. Select one of the files below to import.
4. Be sure to check the "Half Height" option, then click Open to
import the graphic. NOTE: Make sure you are in Tall Text view in
order to see the increased quality .

File: m640.GW.BlkWht
Graphic Mode: 640 x 200 dither mode
Palette: Black and White only
Rendering:

Error diffusion

Vertical Scaling: 2:1

File: m640.GW.Grays
,.

'

Graphic Mode: 640 x 200 dither mode
Palette: Grayscale
Rendering:

Error diffusion

Vertical Scaling: 2:1
Because GraphicWriter III has a fixed, dithered palette of colors, some
gray shades are translated into a color that simulates that shade of gray.

File: m640.GW.Colors
Graphic Mode: 640 x 200 dither mode
Palette: Default color
Rendering:

·r

Pattern dither

Vertical Scaling: 2:1
This graphic is identical to the earlier 640 mode conversion titled
"m640.Dcolor.Def, " except that this graphic is stretched to twice the height
for GraphicWriter III.
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Reference
The Reference sectio n describes all the features found in SuperConvert.
This sect ion is organized for reference-use it to learn about a specific
feature.
A particular topic or command can be found in the Table of Contents or
Index.
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Load Formats Window
Load Formats are the grap hic formats that SuperConvert can load and
convert. The Load Formats window is divided into two lists: the top list
shows the types of computers (plus a category for formats not speci fic to
any one comp uter). Selecting a comp uter type upd ates the bottom list to
display the actual formats for that computer.

AtariST
Amigo
Com11odore
64/128
Hocintosh
IBHPCi compatibles
/\ Co11puter
tupe (
Load )
( Infoonformat) Specifie tupeV
~-~·-·

Tl

,.

Uricompressed
SHR
screen($Cl,BIN)-0Paintworks
Gold640modefiles
PrintShopllgs colorgraphic
PSllgs built-in(GRAPHIC.CGT0-7)
findericonfile
*AST
picturedatafile (coloronlH){}
Tbe Load Formats window
_1

·-

To choose a particular load format you make a selection in both the top
and bottom lists. NOTE: Tbe selections in the Load Format window are
only relevant when you are loading an image-they have no other effect .
Clicking the Load button in the Load Forma ts window is equivalent to
selecting the Load & Convert comma nd on the File menu. If you se lect
multiple files to load, the button changes co lor and shows "Load Next"
(which is equivalent to the Load Next command on the File menu).

'1
l

Clicking Info On Forma t opens the Help w indo w and goes directly to the
page corresponding to the current ly se lected format.

'1
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Normally, if any problem is encountered while loading a file you will
receive an error alert and will not see any portions of the converted
picture. If this happens you can attempt to recover the picture by holding
down the O key and clicking in the area where the conversion window
would appear (or anywhere else in the background). If the picture seems
to be completely unrecoverable, you'll get a beep and nothing else. If
there is any hope , the picture will be displayed and all the menu options
for saving and modifying it will be activated. WARNING: There is a slight
possibility that the partial picture information in memory is not reliable,
and a system crash can occur (either immediately or during a future
conversion).

Transfer Notes
SuperConvert can only load graphics from disks recognized by the IIGS
operating system. Currently (as of System 5.0.4) only GS/OS or ProDOS
disks are recog nized. This means that if a graphic resides on a "foreign
format" disk, suc h as DOS 3.3, IBM, or Macintosh, it must first be
transferred to a IIGS disk (ProDOS or GS/OS format).
One transfer method is by modem to download files from electronic
services, or transfer files with other computers. Some services post large
files in a compressed format which are mea nt to be "unpacked " once the
file has been downloaded.
Super Conve rt recognizes some forms of
compression, but not all files will work. For this reason we stro ngly
recommend first downloading one graphic to verify the format is
supported.
Other methods of transfer are available for so me formats. General
information is provided in this sec tion ; any specific notes on a particular
format will be described in the sections that follow.
Transferring files from DOS 3.3: When the ProDOS operating system
was first released, it included a program called "Convert" that would read
files from a DOS 3.3 disk and write them to a ProDOS disk. If you can
find an ear ly ProDOS disk you may find and use this program. Copy II
Plus from Centra l Point Softwa re also has an option to convert DOS 3.3
disks into ProDOS.
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Transferring files directly from Macintosh and IBM: The program
Apple File Exchange CAFE)is supplied free with the Macintosh. AFE can
transfer files from the Mac onto a IIG S disk. When used on a Macintosh
that has a "SuperDrive," AFE can also transfer IBM files to a IIGS disk.

There are also public domain or shareware utilities that can directly read a
Mac disk on an Apple II: MacTransGS for the old single-sided 400K (MFS)
disk format, and A2FX for BOOK(MFS) disks. Your local user's group may
be able to provide copies of these program s, or they can be found on
major online services.

Format Descriptions
For each load format discussed below, there is a summary of the following
informa tion:
Programs: Which program s, or the types of programs, that produce
this graphic format.
Resolution: The maximum size and colors that the format supports.
Result: The grap hic mode and picture size that results from loadin g a
graphic with this format:
If the source graphic's reso lution is no better than the IIG S, the
graphic is imm ediat ely load ed as a "scree n image" (either 320
mode or 640 mode).
If the sou rce graphic's resolution is bette r than the IIGS, the
graphic is loade d as a "true color image" and the "Remap Image"
dialog box is displayed so you can create a scree n image that the
JIGS can display.
Following the su mmary there may be specific note s or tips on using a
particular format.
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Apple II Family Load Formats

1:
1

HiRes (Black & White and Color)

It [

Programs:
Resolution:

Various (816/Paint, MousePaint, etc.)
B&W: 280 x 192, black & white
Color: 140 x 192, 6 colors

Result: B&W or Color: 320 mode, 280 x 192

Double HiRes (Black & White and Color)
Programs:
Resolution:

Various (816/Paint, DazzleDraw, etc.)
B&W: 560 x 192, black & white
Color: 140 x 192, 16 colors

Result: B&W: 640 mode, 560 x 192
Color: 320 mode, 280 x 192

Print Shop Black & White Graphic
Programs
Resolution

Print Shop (original version, not "New Print Shop" or
"Print Shop I!GS")
88 x 52, black & white

Result 320 mode, 88 x 52
Print Shop uses DOS 3.3-formatted disks, so you first have to transfer the
files to a ProDOS disk.
Print Shop graphics from other machines might also be compatible, but
this has not been tested.
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TDM 40- and 80- Column Text Screen Captures
Programs: TDM (The Desktop Manager, a utility package from On
Three, Inc.)
Resolution: 40-column: 40 x 24
80-column: 80 x 24
Result: 40-column: 320 mode, 280 x 192
80-column: 640 mode, 560 x 192

NO'IE: The TDMformat is listed under the Apple ll category because, while
TDM runs only on the Apple JIGS,the file format can be generated easily on
any Apple II.
This conversion actually reads the character set ROM in the IIGS to
produce an exact graphical repre sentat ion of a text screen, even if a
foreign-language character set is se lected . WARNING: The proprietary
technique used to read the JIGScharacter set ROM cannot be guaranteed to
work on future revisions of the JIGS. Also there may be problems with future
accelerator products: it works fine with the current Trans Warp GS at
7MHz, but accelerators that run faster or use a different technique may
cause this conversion to malfunction. If this happens, you may need to
temporarily slow the accelerator down to normal JIGSspeed.
The TDM format is a BIN file containing a raw image of the text screen
memory. For example, using AppleSoft BASIC under DOS 3.3 or ProDOS
you could save a 40-column screen with the command:
BSAVE filename,A$400,L$400

80-column screen saves should store the auxiliary memory hal f of the
screen before the main memory half. Files created in this mann er won't
contain information on the setting of the alternate character se t mode at
the time the save was made, therefore they may appear incorre ctly when
first converted. If this happens, choose Re-Convert Last File from the File
menu to perform the conversion using the opposite charac ter set mode.

Apple II Family Load Formats
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Apple IIGS-Specific Load Formats
SuperHiRes ($CO/PNT, $C1/PIC)
This load format handles all of the common IIGS-specific graphics file
formats automatically. The individu ally supported formats are:
Type
Type
Type
Type

$CO, Auxtype
$CO, Auxtype
$CO, Auxtype
$Cl, Auxtype

0-PaintWorks Plus 1.0
1-PackB ytes
2-Apple Preferred
0-Unco mpr esse d Screen

If yo u load a file of another type (by ch eck ing the "Allow files to be
select ed regardl ess of type" option), it will be interpreted as a PackBytesformat file. Some programs (usually games) use that format but assign the
files a different type.

Type $CO: Auxtype 0-PaintWorks
Programs:
Resolution:

[

l

Plus 1.0

First release of PaintWorks Plus only used this format,
later versions retained it as an option
320 x 396, 16 colors from a palette of 4096

Result : Same as the original (no conversion)
This format contains 514 bytes of information on the current drawing color
and patterns. Supe rConve rt stores this da ta from the most rece ntly load ed
PaintW orks picture, and includes it with any file saved in this format. It is
therefo re highly recommended that you load at least one file of this format
before saving anything in this format, o therwise the resulting picture will
no t have any drawing patterns and will be difficult to edit in PaintWorks
Plus.

Type $CO, Auxtype 1-PackBytes
Programs:

816/Pa int compr essed scree n format, FantaVision IIGS

f

Resolu tion: One full screen , all IIGS SHR graphics features are
poss ible
Result: Same as the original (no conve rsion)
This is referred to as the Eagle format in so me d ocu mentation. This
format is almost compl etely unsupported by IIGS grap hics program s.
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Type $CO, Auxtype 2-Apple
Programs:
Resolution:

Preferred

Almost every IIGS-specific program,
a few Apple II programs
Virtually any size; all IIGS SHR graphics features are
possible

Result: Same as the original (no conversion)
This is the IIGS graphics format of choice. It has provisions for handling
images far larger than available memory (however,
all existing
implementations-including
SuperConvert-place
a much stricter upper
limit on size). Delux ePaint II established the following maximums, which
are also used by SuperConvert:
Maximum Height: Two screens (400 pixels)
Maximum Width: Two screens (640 pixels in 320 mode, 1280 pixels
in 640 mode)
Image size is furth er limited to a maximum of 65,536 bytes of raw pix el
data (slightly more than two screenfulls in area). This limit is illustrated by
the curve shown in the View Half Size disp lay.
Files in this format consist of a series of named segments, also referred to
as records or blocks. When such a file is loaded, you'll get a dialog box
with a list of the segments in the file. Those that SuperConvert can do
something with will appear as buttons, others will just be tex t. A "MAIN"
segment contains an actual picture Citis almost always the first segment in
the file, and just hitting Return will cause it to be loaded).
Other support ed segment types are "SHRConvert" and "SuperConvert,"
which contain the version number of th e program that saved the file so
that any problems with it can be traced back to the source.
Other
segments contain no usable information, but their existence can help
identify the source of the file. For example, pictures saved from Platinum
Paint have a "Platinum Paint" segment, DeluxePaint pictures have an
"EOA" segment, and PaintWorks pictur es have seg me nts such as "VSDV"
and "VSDK."
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Type $C1, Auxtype 0-Uncompressed
Programs:
Resolution:

Screen

Almost every IIGS-specific program,
a few Apple II programs
320 x 200, 16 colors
640 x 200, 4 colors taken from a palette of 4096

Result: Same as the original (no conversion)
All IIGS graphics features are available, such as mixing the two graphics
modes or having up to 16 independent color palettes, but few programs
will accept or produce files containing these variations.

Uncompressed SHA Screen ($C1, BIN)
Programs:
Resolution:

almost every IlGS-specific program, a few Apple II
programs
320 x 200, 16 colors
640 x 200, 4 colors taken from a palette of 4096

Result: Same as the original (no conversion)
This is the same format as "Type $Cl, Auxtype 0-Uncompressed Screen"
· except that this load format doesn't care as much about the file's exact
type and auxtypc (this lets you to load the occasional file that doesn't
have the right types). In particular, many of the pictures that were
available when the IIGS first came out were incorrectly given a filetype of
BIN.

If you check the "Allow files to be selected regardless of type" option, you
can also use this load format to load the first frame of a PaintWorks
animation file (type $C2).

r
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PaintWorks Gold 640 Mode Files
Programs: PaintWorks Gold
Resolution: 640 x 200, 4 colors taken from a palette of 4096
Result: Same as the original (no conversion)
None of PaintWorks Gold's three save formats produce valid files when
the program is in 640 mode. The usual symptoms when such files are
loaded by a program that properly implements the formats include
incorrect colors and half-width images. This special load format is
provided to handle these files "properly " (by loading them improperly to
compensate for the defects in the files).

1
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Print Shop IIGS Color Graphic
Programs: Print Shop IIGS

In
l

After loading the faulty PaintWorks Gold picture you can save it in a
proper format, such as "$C0,2 App le Preferred."

'T

Resolution: 88 x 52, 8 fixed colors (black, white , red, orange, yellow,
green, blue purple)
Result : 320 mode, 88 x 52, default palette, only 8 colors used

Print Shop IIGS Built-In Graphics
Programs: Print Shop IIGS
Resolution: Contains six named PS IlGS color graphics, each 88 x 52,
8 fixed colors (black, white, red, orange, yellow, green,
blue purple)

J

Result: 320 mode, 88 x 52, default palette, o nly 8 colors use d
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Finder Icon File
Programs: The Finder and various icon editors (DlcEd, IconEd, etc.)
Resolution: Varies
Result: 640 mode, image size is a few pixe ls larger than the icon
in all directions to mak e the background color visible,
uses default palette
You can select any icon contained in the file you load. All Finder options
that affect the appearance of the icon can be simulated: large/small icon
selection, icon coloration, and the effects of the icon being opened,
offline , or selected. Also, any background color for the icon can be
selected.

AST Picture Data File (Colo r Only)
Programs: VisionEffects, the software supplied with the AST
VisionPlus video digitizer card . Files must be saved as
picture data files from 320 mode, full color. Also supports
files from the Allison digitizing program.

l
1r

:r

r
f ['

This load format is intended to provide a way to generate digitized screen
images of much higher quality than the VisionEffects software is capable
of. Compatibility with software for the Visionary card (an enhanced
version of the VisionPlus) has not been determined.
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Reso lution: 320 x 200, 4096 colors
Result: True color image, 320 x 200
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"3200 Color" Pictures (Uncompressed and Compressed)
Programs:

I

Various, including the software for the Visionary video
digitizer card

Resolution: 320 x 200, potentially 3200 colors (there are numerous
restrictions on what colors go where, making the actual
number of colors generally no more than a few hundred)
Result: True color image, 320 x 200
The se pictures are intended for use with special display programs that
change the color palette for e ach row of pixels, making it pos sible to
display 3200 (200 lines, 16 colors per line) colors at once.
The results can be excellent, but unfortunately the critical timing
requirements of this technique make it necessary for suc h display
programs to completely shut down interrupts , a normal IIGS function that
is used by things such as AppleTalk, various desk accessories such as
alarm clocks and screen blanker s, and other ordinary operations. This
inherent incompatibility with norm al IIGS functioning restrict s the
usefulness of the 3200 color format. This load format is provid ed so that
you can convert any 3200 color pictures you hav e into normal formats that
might not look quite as good, but don't disrupt normal operation of the
computer.
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Atari ST Load Formats
In addition to the formats listed be low, you may occasiona lly run across
an Atari ST picture with a filename ending in .PQl, .PQ2, or .PQ3. These
are standard .PI1-.PI3 files that have been comp ressed with the standa rd
Huffman SQ algo rithm. They can be unsqueeze d with a utility such as
Shrinklt, AUSQ, or BLU. Endings of .TNl, .TN2, or .TN3 might indicate a
file tha t is in .TNY format, but no samp le files have been tested.

Degas (.Pl1, .Pl2, .Pl3)
Prog rams: Degas, Degas Elite
Resolution:

.PII: 320 x 200, 16 colors from a pa lette of 512
.Pl2: 640 x 200, 4 colors from a palette of 512
.PI3: 640 x 400, b lack & white

Result: .Pll : 320 mode, 320 x 200, 16 colors
.PI2: 640 mode non -dithe red, 640 x 200, 4 colors
.PI3: 640 mode non-dithered, 640 x 200, 4-level graysca le

Degas Elite (.PC1, .PC2, .PC3)
Programs:
Resolution:

II
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Degas Elite
.PCl: 320 x 200, 16 colors from a palette of 512
.PC2: 640 x 200, 4 colors from a palette of 512
.PC3: 640 x 400, black & wh ite

Result: .PCl: 320 mode, 320 x 200, 16 colors
.PC2: 640 mode non-dithered, 640 x 200, 4 colors
.PC3: 640 mode non-dithered, 640 x 200, 4-level
grayscale
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Neochrome (.NEO)
Programs:

> -

Neochrome

Resolution : 320 x 200, 16 colors from a paleue of 512
Result: 320 mode, 320 x 200, 16 colors
Ail three Atari ST resolutions are repres e ntable in this format, howev er the
Neoc hrome pro g ram apparent ly only produces 320 x 200 pictu res.
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Tiny (.TNY) Compressed
Programs:

I

Resolution:

Interchange format only; no known program uses this as
the default setting
Type 1: 320 x 200, 16 colors from a palette of 512
Type 2: 640 x 200, 4 colors from a palette of 512
Typ e 3: 640 x 400, black & white

Result: Type 1: 320 mode, 320 x 200, 16 colors
Type 2: 640 mode non-dithered, 640 x 200, 4 colors
Type 3: 640 mode non-dithe red , 640 x 200, 4-level
grayscale

Spectrum 512 (Uncompressed and Compressed)
Programs:
Resolution:

UniSpec, DigiSpec, etc.
320 x 199, 512 colors (it's actually 320 x 200, but the top
line is always solid black due to limitations of the format).
There are up to 15 colors availab le for any one pixel, but
the available colors are changed three times per row of
pixels, making it possible to have all 512 colors on the
screen.

Result: True color image, 320 x 200
There is a third Spectrum 512 format (filename ends with .SPS) but de tails
of this format have not been made public.

11
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Amiga Load Formats
IFF (FORM ILBM only)
Programs:
Resolution:

Virtually all Amiga graphics programs

t

Arbitrary size , 2-32 arbitrary colors, or 64 or 4096 limited
colors

Res ult: True color image, same size as the original
This load format hand les FORM ILBM structures in any IFF file (including
FORM ILBMs buri ed inside other structures) that describe a normal Amiga
disp lay mod e, including EHB (Extra HalfBrite) and HAM (Hold-AndModify) . Synthetic and non-displayab le modes (SHAM, Dynamic HAM,
Dynam ic HiRes, HAM-E, RGBN, RGB8, e tc.) are not currently supported.
The IFF format is used for many things bes ides graphics on the Amiga:
music, digiti zed sounds, and word processo r documents to name a few.
Each type of data is labelled as a specific FORM within an IFF file: ILBM
for graphics, SMUS for mu sic , and so on. It is possible for a FORM or
other IFF st ructure to conta in other FORMs. For example, a document
FORJ\1might contain a FORM ILBM that specifies a picture that is included
in the document. SuperConvert should be able to find a FORM ILBM no
ma tter how deeply it is buried in an IFF file's structure.
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Commodore 64/128 Load Formats
Doodle
Progr ams: Doodle
Reso lution: 320 x 200, 16 colors (2 color choices per 8 x 8 pixe l area)
Result: 320 mode, 320 x 200

Koala Illustrator
Programs:
Resolution:

Koala Illustrato r
160 x 200, 16 colo rs (4 co lor choices per 4 x 8 pixel area)

Result: 320 mode, 320 x 200

Print Shop Screen
Programs:
Resolution:

Print Shop
320 x 200, black & white

Result: 320 mode, 320 x 200
There is a possibility of gett ing at least a B&W ima ge out of so me other
C64 picture formats by using this load type.
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Macintosh Load Formats
Downloading Notes
All downloaded Macintosh files (other than plain text) will be in a spec ial
format kn own as MacBinary: to use suc h files, the 128-byte MacBinary
header mu st be stripped from the file. Assuming that the file is not larger
than approximately 32K, the following commands from ProDOS BASIC
will accomplish this (for safety, do this on a copy of the file):
BLOAD MACPIC,tTXT,a$1000
BSAVE MACPIC,tTXT,a$1080
(Replace "MACPIC"and "TXT" with the file's actual name & type.)

t

l

In addition to MacBinary, many Mac files will be in a compressed format,
such as Packit or Stuff1t. Packit files can be unp acked, and MacBinary
header s removed , with the utility MacDown. Stuffle files can be unpacked
with Shrinkit -GS. Both of these programs are available on the major
online services, and also might be available through your local use r's
group or computer dealer.

MacPaint=>
Programs:
Resolution:
Result:

640 Mode Grayscale
MacPaint and othe r Mac graph ics programs that support
the MacPaint format
576 x 720, black & white
640 mode non-dithered, 576 x 360, 4-level grayscale

The default save format for MacPaint II is not this format, altho ugh the old
MacPaint format is available as an option.

.'
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MacPaint => 320 Mode Black & White
Programs: MacPaint and other Mac graphics programs that support
the MacPaint format
Resolution: 576 x 720, black & white
Result: 320 mode, 576 x 227 (the bottom of image is lost due to
screen image size limits)
The default save format for MacPaint II is not this format, although the old
MacPaint format is available as an option.

ScreenMaker (Startup Screen)
Programs: ScreenMaker, converts MacPaint pictures to this format
Resolution: 512 x 384, black & w hite
Result: 640 mode non-dithered, 512 x 192, 4-level grayscale

[ r

This is the startup screen format for older Macintoshes onl y ! The
Macintosh SE and Macintosh II use a different format which SuperCon vert
doesn't support. Also, there are other various "startup screen" programs
that use their own format, and those formats are not supported.

J,
Jf

J
:J

• I

'

MacintoshLoad Formats

51

rr
IBM PC & Compatible Load Formats
Each IBM program that support s a particular format seems to do it
differently from the others, and to do it slightly differently for each of type
of IBM display card th at th ey support.
This makes it impossible to
guarantee that SuperConve rt will be compatib le with all files of a
particular format.

rr

PC Paintbrush (Full Screen and Clipping)
Program s: PC Paintbrush

rrr

Resolution : Arbitrary size, 2-256 colors, but only 2-16 co lor files are
currently suppo rted
Result: True color image, same size as the orig inal

DeluxePaint II, not Enhanced
Programs:

DeluxePaint II

Reso lution: Arbitrary size, 2-256 colors
Result:

Tru e color imag e , same size as the origina l

The o rigin al De luxePaint II for the IBM used a format ident ical with the
Amiga IFF forma t for graphics (FORM ILBM), with the sing le exception
that it supports 256 color image s wh ich aren 't poss ible on the Amiga.
Unfortunat e ly DeluxePaint II Enhanced use s an in compatible varia tion on
the format. Details on the va riation haven't bee n found, so SuperConvert
does n 't support thos e files. There is no way to tell whe ther a particular
file is in the old o r new forma t ot her than trying to load it.

AutoDesk Animator Frame File from FliAway
Progra ms : Only compatible w ith the individua l frame files created by
th e FliAway utilit y (provided on the SuperCo nvert d isk to
extract Autodesk Animator frames from .FLI an imation
files)
Resolu tion : 320 x 200, 256 colors out of a palette of 262,144
Resu lt: True color image, 320 x 200
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GIF (Graphics Interchange Format)
Programs: Various
Resolution: Arbitrary size, up to 256 colors out of a palette of
16,777,216 possible colors
Result: True color image , same size as the original

'

.,.

Computer-independent
formats are standa rd graphic formats that are
supported by a variety of computers. By us ing these formats it is po ssible
to get graphics from any machine to anothe r machine just by hav ing
conversions to and from a "computer-independent"
format on each
compute r.

T

GIF (Graphics Interchange Format) is a format deve loped by CompuServe,
Inc. for the transfer of graphics between different computer types .
Programs that produce GIF files can be found on most computer systems
wi th graphics capability. If SuperConvert does not support a particu lar
graphics format from another computer, chances are good that you can
find a conversion utility on that computer that will convert that particular
graph ics format into a GIF file. After you convert the graphic to a GIF file,
you can transfer it to the IIGS and load it with SuperConvert.
NOTE: 1be original version (8 7a) of the GIF specification isfully supported.
Files that use features fr om later revisions of the specification will conver t,
but portions of the p ictum may be m issing or distorted.
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RLE (Run Length Encoded)
Prog rams: Various
Resolution:

IJ

]~

256 x 192 or 128 x 96, black & white

Res ult: 320 mode, 256 x 192 or 128 x 96

Downloading Notes
RLE pictures u sua lly have filenames ending in .RLE (on CompuServe they
will have a "/grap h:RLE" flag after their name in the directory listing).

;r 1

11

RLE pi ctures co ntain on ly 7-bit ASCII data, and do not hav e to begin
precisel y at the start of the file. This mea ns that you can use yo ur
telecommunication
program' s capture buffer to grab an RLE graphic
without havin g to worry about any excess data before or after the actual
image. However, your pro gram mu st be capable of capturing control
chara cters (especially the ESCape character) .

_LI

n

IPI Image
Programs:

I[

u

T
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Unknown

Reso lution: 256 x 256 or 512 x 512, 16,777,216 possible colors
Resu lt: Tru e color image, same size as the original
This format is different from the others that Sup erConvert supp orts, in that
eac h image is composed of three sepa rate files containing the red, gree n,
and blue portions of the image. Select any of the three for loading (the
other two wi ll be loade d automat ically). For this to wo rk, all three files
must hav e id entica l n ames except for the endings, wh ich must be ".R",
".G", and ".B". If the files are named differenLly, they must be renamed
before they can be loaded.

I ·,

I.

Thi s file format was used at the Image Process ing Institute of Lhe
Univers ity of Southern Californi a for ea rly expe riments in digital image
processing.
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Quick Ray Tracer (QRT} Raw Image File
Programs:
Resolution:

Quick Ray Tracer
Arbitrary size, up to 16,777,216 possible colors

Result: True color image, same size as the original

1

Quick Ray Tracer (QRT) is a program available on several computers for
producing computer-generated images from a mathematical description of
a scene. While there isn't a IIGS version of QRT at this time, if one is ever
available it will presumably use the same file format. Until then you can
use this load format to convert QRT files to a IIGS-displayable graphic.

1
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Save Formats Window
Save Formats are the graphic formats that SuperConvert can save. NOTE:
The selection in the Save Fonnat window is only relevant when you are

saving an image-it has no other effect.

$C1uncompressed
screen
findericon(newfile)
The Save Fonnats window
Clicking Info On Format opens the Help window and goes directly to the
page correspo nding to the currently selected format.
Clicking the Save button in the Save Formats w indow (visible only if a file
has been successfully converted) is equivalent to the Save Conversion
command on the File menu.

Format Descriptions
.r'

,

lf I,
.l

For each save format discussed below, there is a summary of the following
information:
Default Suffix: The suggested file suffix.
Programs: Examples of programs that this particular format can be
used with.
Picture Info: The filetype, auxtype, and length of the files saved with
this format. Also the picture size, where applicable.
Limitations:
Any limitations the re might be in using this particular
format.
Following the summary there may be speci fic notes or tips on using a
particular format.

Save Formats Window
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$CO,O PaintWorks Plus v1 .0

r

Default suffix: PNT
Programs:

PaintWorks vl.0 used this format rather than the Apple
Preferred format , which wasn't defined at the time. Some
other programs can read this format, and a few can write
it.

Picture Info: Filetype $CO, auxtype $0000, length varies
always one screen wide, 396 pixels high
Limitations: Only 320 mode graphi cs are allowed (there is a variation
of this format that handles 640 mode, but it is not
supported because only PaintWorks Gold uses it, and that
program can handle other 640 mode formats). Multiple
color palettes are impossible to repre sent in this forma t.
This format will probably not be supported by future programs, so don't
use it unless you have to. Before saving any files in this format, you
should load one real PaintWorks picture to properly establish the drawing
pattern s.
This format contains 514 bytes of information on the current drawing color
and patte rns . SuperConvert scores this data from the most recently loaded
Pain tWorks pi cture, and includ es it with any file saved in this format. It is
highly recommend ed that you load at lea st one file of this format before
saving anything in this format, otherwise the resu lting picture will not have
any drawing patterns and will be difficult to edit in PaintWorks Plus .
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$CO,OPaintWorks Plus v1 .0 Save Format
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$CO,1 PackBytes
Default Suffix: PAK
Programs:

Only 816/Paint and FantaVision GS see m to use this
format

Picture Info: Filetype $CO, auxtype $0001, length varies
always one screen wide, one scree n high
Limitations: All IIGS graphics features are possible, but individual
programs may imp ose restrictions suc h as a single palette
or 320 mode only.
This is not an officially-sup ported format; don't use it unl ess you have to.
About the only legitimate use for it is in programs you write yourself, with
no need for the pictures eve r to be used anywhere else, since the format is
a good compromise between minimizing file size and ease of writing code
to load the picture.
Also known as the Eagle format in some documentation.
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$CO,1 PackBytes Save Format
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$C0,2 Apple Preferred
Default Suffix: SHR
Programs: All IIGS graphics programs should read/write this format.
Picture Info: Filetype $CO, auxtype $0002, length varies
virtually unlimited size, either larger or smaller than the
screen. All current implementations impose some size
limit, which is no larger than two screens wide or two
screens high, or 65,536 bytes of raw data
Limitations: All IIGS graphics features can be represented in this
format, but programs that support the format generally
impose additional restrictions, such as a single palette.
Some programs cannot handle files with a width other
than one screen.
Use this format if possible. Note that you can load these files (if no larger
than one screen) directly into DeluxePaint II as brushes.

60

$C0,2 Apple Preferred Save Format
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$C1 Uncompressed Screen
Default Sufftx: SCR

II

Programs: All JIGS graphics programs should be able to read this
format.

l

Picture Info: Filetype $Cl, auxtype $0000, length 32,768 bytes
always one screen wide, one screen high
Limitations: All JIGS graphics features are possible, but few programs
can handle some features such as mixed graph ics modes
and multiple palettes.
Because this format's lack of compression makes for larger files, it should
genera lly only be used in conjunction with other programs that are
incapable of reading the standard compressed formats.
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$C1 Uncompressed Screen Save Format
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Finder Icon New File and Add to Existing File
Default Suffix: ICN
Programs:

The Finder and various icon editors (DicEd, IconEd, etc.)

Picture Info:

New File: filetype $CA, auxtype $0000, length varies
Existing: filetype and auxtype unchanged, length varies

Limitations:

Each icon must be 640 mode, standard color palette.
Image size cannot exceed 160 x 50, with 80 x 25 being
the largest you should normally make an icon.

I
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This format appears twice in the list of save formats, once for making a
new icon file containing one icon, and another for adding icons to an
existing file, perhaps one you just created with the first option. If you are
making icons for a group of files that are likely to stay together, it is a
good idea to put their icons together in one file (this reduces memory,
disk space, and loading time requirements for the icon file).
Do not use "Add to Existing File" to add icons to any of the icon files that
came on your System Disk! Any icons you add will be overwritten
whenever you install a new System version.
Icon files contain more than just the images of the icons: they also
contain information about which file or files each icon is to be used with.
Also, there is a small icon associated with each full-size icon. Therefore,
when saving an image in this format a dialog box appears so you can
specify all of this extra information. Initially, all options will be set to
associate the icon with the most recently loaded file, and to have the icon
automatica lly run SuperConvert when it is opened. You can modify any
of the selection criter ia, or t1.1rnsome of them off to allow the icon to be
used for a group of files.
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Finder Icon Save Format
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If you want the sma ll icon associated w ith your full-size icon to be
something other than the generic document icon, you can draw whatever
sort of image you want using the icon editor at the upper right of the icon
options dialog:

Editing a small icon
Drawing is performed in the magnified view area.
there and in the actual size area.

The results appear

If the Color box is checked, the Finder won't allow the user to change the
icon 's colors.
Clicking on the actual size small icon steps through the various ways the
icon can appear in the Finder due to it being open, offline , or se lected.
Clicking on the drawing tool steps through the available tools:
Pencil-Dr aws in the se lected color. Areas drawn with the "NONE"
color will be transparent.
Paint can- Erases with the selected color
Hand-Repositions icon image

1
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Each of the little square boxes in the magnified view actually repr ese nts
two pixels , which together form one of the 16 possible dithered colors.
Normally, drawing affects both pixels of each pair at once: if you need to
do some very detailed drawing, clicking on the half -pixe l box wi ll
enable / disable a mode in which the individual pixe ls of each pair can be
separately drawn . Half-pixel drawing can be confusing, especially with
colors, because two pixels combine to create a color.
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Finder Icon Save Format
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Desktop Background Image INIT
Default Suffix: ICI
Programs:

The output of this save format is a program that is
intended to be placed in the System/System.Setup folder
of your startup disk. Putting one anywhere else has no
effect. When a disk with one of these files is started, the
picture contained in the file will be installed as the
background image for all normal desktop programs.

Picture Info: Filetype $B7, auxtype $0000, length 32,862 bytes
always one screen wide, one screen high, with the top 13
pixels being covered by the menu bar. Larger images are
chopped off at the bottom, smaller ones are centered on a
light blue background.
Limitations: Any image can be saved in this format, but it won't look
right unless its palette matches the palette of the programs
it appears in. Use the Remap command to chang e an
image to a different palette or mode.
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Desktop Background Image INIT Save Format
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GIF (Graphics Interchange Format)
Default Suffix: GIF
Programs: While there are a few Apple II programs which can use
GIF files, this save format is primarily intended for moving
graphics to other machin es . Programs that can convert or
use GIF files exist for virtually all computer systems that
have graphics capability.
Picture Info: Filetype $06, auxtype $0000, length varies

] '1
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Limitations: Pictures using mixed 320 and 640 modes cannot be saved
in this format. Multipalette pictures and pictures using
dithered colors in 640 mode can be saved as GIF, but
they may not look quite the same on another IIGS since
the information needed to recrea te these lIGS-specific
features cannot be stored in a GIF file.

NOTE: Saved files conform to the original (87a) version of the GIF
specification .
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GIF (Graphics Interchange Format) Save Format
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TIFF (Tagged Image File Format)
Default Suffix: TIF
Programs:

No Apple II programs are known to use TIFF files at this
time. However, many desktop publishing and othe r types
of programs for the IBM, Macintosh, and other computer
systems can load TIFF files.

Picture Info: Filetype $06, auxtype $0000, length varies
Limitations: 320 mode pictures come out best; the color dithering that
is used in 640 mode graphics does not translate we ll to
other computers.
TIFF is an extremely flexible format, perhaps too flexible for its own good.
There are hundreds of legal variations of TIFF files, and new variations
can be introduced at any time. Unfortunately, most programs that claim
TIFF compatibility only support a small fraction of these possibilities. To
max imize your chances of successfu lly usi ng TIFF files, SuperConvert
disp lays a dialog box that gives you various options to contro l exactly how
the file is stored.
The first time you save an image in TIFF format for use with a particular
program, you should save several files using different combinations of
options, and see which ones work the best. Unfortunately, no guarantee
can be made that the files will work at all wit h any particu lar program or
program version. We have tested this option with the following programs:
• Aldus PageMaker v4.0 for the Macintosh-Use either byte ordering
(Motorola preferred), do not leave sizing dec isions to the receiving
program, and check the "Increased Compatibility" option.
• Aldus FreeHand v3.0 for the Macintosh-Use either byte ordering
(Motorola preferred), do not leave sizing decisions to the receiving
program, and check the "Increased Compatib ility" option.
After saving the TIFF file it must be transferred to the destinat ion
computer. Once there, you may need to change the "filetype." For
example, on the Macintosh you need to change the file's "Type" and
"Creator" (we use a desk accessory called DiskTop). The "Type" should
be "TIFF" (all capita l letters). The "Creator" is less important (we usua lly
just specify "???? ").
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TIFF (Tagged Image File Format) Save Format
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Screen Image Window
After successfully loading a picture, Su perConvert displays a window
containing the screen image of the picture. If you load a true color image
(format names that begin with an asterisk), the Remap dialog box is
automatically shown to allow you to generate the initial screen image .
The colors in the Screen Image window usually won't be right because the
arbitrary colors of an arbitrary picture cannot be displayed on the screen
simultaneously with the fixed colors of Su perConvert's menus and
windows.
When the Screen Image window is active, you can drag the mouse in the
window to select a rectangular area of the image. You can resize the
selection rectangle without starting over by holding down the Option key
when you click in the window (this lets you reposition the corner closest
to the pointer).
This "clipping area" is used only when saving the conversion. Printing
and other image operations use the entire picture unless you use the Crop
To Clipping Area command.

7
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Screen Image Window
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Menus
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This section is organized by the menu titles and menu commands.

Cqmmand Keys

]

JJ
]

Menus contain all the commands available in SuperConvert. The titles of
all the menus are shown in the menu bar at the top of the screen. To see
the commands available in a menu, pull it down by pointing to its title
and pressing the mouse button. When a command is dim it is not
available at the moment.
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Many commands have keyboard shortcuts that let you give the command
without using the mouse. These shortcuts are listed to the right of the
corresponding commands in the menus. For example, pull down the File
menu and you will see several keyboard shortcuts listed: OL for Load &
Convert, OR for Re-convert Last File, and so on.
To use a keyboard shortcut, hold down the Command key (0) and press
the letter listed on the menu. The Command key has a hollow apple and
a cloverleaf on it, and is located between the Option key and the tilde key
at the lower-left of the keyboard. NOTE: Although shortcuts in this
manual are shown as uppercase, all SuperConvert shortcuts can be
accessed by holding the Command key and typing either a lower case or
upper case letter.
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AboutSuperConvert
Choose About SuperConvert from the II (Apple) menu to display the
program's version number and copyright information.

IContinueI

r' I.
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SuperConvert
version3.01
Copuright
© 1987-91
JasonHarper
AlI rightsreserved.
Program
name
is a trade11ark
ofSevenHi!Is Software
Corp.
About SuperConvert dialog box
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Menus: tt (Apple) Menu
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Shortcut: O? or 0/
-

Choose Help from the • (Apple) menu to display the online help. An
error is displayed if the help files cannot be found in the same folder that
SuperConve rt itself was run from, or if there was insufficient memory to
load them. Giving this command while the he lp w ind ow is already on the
screen will bring it in front of all othe r windows.
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Version
3.01
Writtenb11
JosonHarper
Selectthe area!IOUwantto getmore
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aboutbyclickingonit.
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o_rm_at...;.s
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Closethis window
when11ou've
hadenough
help.
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(== Click onthe Ho
mebuttonat anuti11eto returnhere.

The Supe,-ConvertHelp wi nd ow
Clicking a button either disp lays he lp for that item, or further top ics to
choose from. Click the close box to close the help w indow.

NOTE: The helpfiles occupy ove,-100K of memory while the help window is
open. Afte,- the window has been closed, this memory is available for othe,uses. If yo u are going to be doing something that requires a lot of memory
(such as working with a large true color image), close the help window first .

Menus: Ii (Apple) Menu
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Menu Item Help
Choose Menu Item Help from the ti (Apple) menu to get help for a menu
item. After choosing this option, the mouse pointer temporarily turns into
a "Menu Item" pointer:

'-:1~:11•0~:1

"Menu Item" mouse pointer

Use this pointer to pull down and select a menu item (even if it's dim).
This will open the online help display and go directly to the page
corresponding to that command .
If you decide you don 't want help after selecting this command, just click
the mouse anywhere and the pointer will revert to normal.
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Menus: • (Apple)Menu

Preferences
Shortcut: 0- or d_
Choose Pref erences from the ti (Apple) menu to change several
SuperConvert option s. Changes to these options remain in effect until the
program is exited; the y are reset to normal the next time you run the
program.

SuperConvert
Preferences

]

D Automotico
l hisavepicture ofter l ooding
D Automoticol
lu print pictureofter loading
D Automoticoll\1
loadnextpictureofter saving
D Don't outoraoticolluviewpictureofter loading

□ Use moodroon
i tor (ottochedto VideoOverlo~Card)for&oO\inious
viewinq

(

Cance
1

)

Ok

)

Preferences dialog box
The first four options are se lf-explanatory, and are intended to make it
easier to conve rt or print large batches of files by minimi zing the nu mber
of times that user interve ntion is requi red .
The fifth op tion, "Use second monitor ... " is on ly enabled if you have an
Apple Video Overlay Card (VOC) installed in your co mputer , the Video
Overlay Toolset (TOOL033) installed on your startup disk, and the VOC
has dual video capab ility (always true of the curre nt mod el).
If you check this option , any full scree n disp lay of the image will "stick"
on the monitor con nected to the VOC, while normal program opera tion
continues on the monitor attached to the back of the IIGS
This could be usefu l in giving a presentation: the presente r could be
loading the next picture on the computer's monitor w hile the audi ence
continu es to view the previous pictu re on a large-scree n TV connected to
the VOC. The "Don't automatically view picture after loading" preference
optio n may be useful in conjunc tion with this opt ion.
WARNING: Do not turn on this option unless you have two
monitors connected as deset ·ibed above! If you don 't have a second
monitor attached, you won't be able to see what you 're doing (if you ignore
this warning, the following sedes of keystrokes should get you back in
control: 0- M Return LJT,).

Menus: • (Apple) Menu
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Desk Accessories
When you start the computer, each desk accessory uses some memory
that cannot be used by SuperConvert.

NO'JE: SuperConvert has been tested extensively. If you experience strange
problems with SuperConvert, remove all desk accessories, then add them
back one at a time to see if a particular accessory is causing the problem . If
the problem still exists with no accessories installed, please send a report to
Seven Hills' technical support.

New Desk Accessories
New Desk Accessories (NDAs) you installed appear under the Ii (Apple)
menu. NDAs are stored in the System/Desk.Aces folder of your startup
disk (filetype $B8).
To use an NDA, choose it from the • (Apple) menu like any other
command. For information about using a particular NDA you must refer
to the documentation that came with it.
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Control Panel

r

Control Panel lets you change various system-related options, including
your printer setup. Refer to the documentation that came with your Apple
IIGS for information about changing the printer type and connection
method.

1·

Disk Initializer

Disk Initializer is provided free with SuperConvert. It allows you to
initialize 3.5" and 5.25" disks without having to quit the program you are
using.

Classic Desk Accessories
To access any Classic Desk Accessories (CDAs) stored in the System/
Desk.Accessories folder of your startup disk (filetype $B9), hold 0 -Control
down while you press and release Esc.
For information abou t using a particular CDA you must refer to the
documentation that came with it.
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File Menu
Load & Convert
Shortcut: OL or click Load in the load formats window
After selecting the kind of file to load in the Load Formats window,
choose Load & Convert from the File menu to choose which graphic files
to convert. Multiple files can be selected: Hold down the Shift key when
clicking to select ranges of files, and hold down the O key to select
individual files. Folders can also be selected, but they will be ignored
unless the "Load all pictures in selected subdirectories" box is checked.
Normally, only those files that appear to SuperConvert to be of the chosen
file format (as determined by the file's filetype, auxtype, and length) will
be selectable; others will be dim. If you want to attempt a conversion on
a file that isn't selectable, you can click the "Allow files to be selected
regardl ess of type" box. Don't do this without good reason because files
that are inappropriate for the selected load format will produ ce
meaningle ss results and can possibly crash the program.
After selecting the file(s) to load, click Accept to load the first one. If
more than one file was selected, the Load Next command can be chosen
to load the next file.

Re-convert Last File
Shortcut: OR

1
'l

Choose Re-convert Last File from the File menu to restar t the conversion
proces s on the file you most recently attempte d to convert (even if the
conversion failed). The new conversion is attempted with the se lected
load format (even if the file doesn't pass the new format's file leng th,
filetype, and auxtype checks). Thus, if you use the wrong load format at
first, you can easily highlight a differen t format and choose Re-conve rt Last
File without having to select the file again.

Menus: File Menu
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Load Next
Shortcut: ON or click Load Next in the Load Formats window
Choose Load Next from the File menu to load and convert the next file
that was se lected with the Shift or O key in the Load & Conver t command .
This command is available only if there are files remaining to convert .
You can choo se Load & Convert from the File menu even when there are
files rem ainin g. Loading a single file will occur immediat e ly without
affecting the remaining files; selec ting multiple files to load will add to the
list of remainin g files, and the next file in the list will be loaded.

Cancel Remaining Files
Choose Can cel Remaining Files from the File menu to remove the list of
remaining files from a multiple file Load command. This command is
available on ly if there are files remaining from a multiple file Load &
Convert comma nd.

Save Conversion
Sho rtcuts: OS or click Save in the Save Formats window
After se lect ing the type of pictu re to save from the Save Formats w indow,
click Save to store a converted picture on disk. This command is available
only when a picture has bee n successfu lly conve rted.

Exchange Load/Save Paths
SuperConvert separate ly remembe rs the disk locations at which you have
most recent ly done a Load or Save ope ration. This makes it easy to
conve rt a se ries of files from one disk to another wit hout having to
navigate to the correct location every time you do a load or save.
Choos ing Exchange Load/Save Paths from the File menu allows you to
swap the rememb ered locations for loading and saving. This is usefu l if
you wa nt to ve rify that a file you just saved looks right (you can exchange
paths, load the graph ic, then excha nge paths again to switch back to the
initial loading/saving locations) .

t
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Print (Normal)
Prints the current screen image to the printer that you chose with the
Control Panel NDA. This command, as well as all other printing-related
commands in SuperConvert, presents two consecutive dialog boxes for
selecting print options, corresponding to the "Page Setup" and "Print"
commands in most other programs.
If the screen image is a 320 mode graphic, SuperConvert temporarily

switches into 320 screen mode to present the print dialog boxes. This is
necessary to insure the printer setup is correct for the graphic mode of the
image being printed.
The "Page Setup" dialog box typically lets you specify information about
the paper size you want to use (specific options depend upon which
printer driver is selected). If the printout will be taller than a single page,
select a "No gaps between pages" option if it is available. See the "Print
Alignment Page" description for a way to eliminate vertical gaps in
printouts that are wider than a single page.
After setting these options, click OK to present the "Print" dialog box for
the chosen printer. Select the number of copies, page range, quality, and
so on (actual choices depend upon which printer driver you are using).
After setting these options, click OK to begin printing.
When printing an image that is larger than the printer can handle, multiple
pages are produced (these pages can be spliced together to form the
entire image). Use the "Print (Enhanced)" command for more control over
this process.
NOTE: Multipalette images will not print properly.

1
'l
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Print (Enhanced)
Shortcut: OP
This variation on the "Print (Normal)" command gives you additional
options to control the sizing and positioning of the screen image on the
paper, and allows you to add a one-line caption in any font. NOTE:
"Enhanced" and "Normal" print refers to the added control over printing; it
does not refer to actual print quality.
After choosing Print (Enhanced), the Page Setup dialog box appears. If
the printout will be taller than a single page, select a "No gaps between
pages" option if it is available (specific options dep end upon which printer
driver is selected). See the "Print Alignment Page" description for a way to
eliminate vertical gaps in printouts that are wider than a single page. See
the "Print (Normal)" section for more information about the Page Setup
dialog box.
After accepting the "Page Setup" options, SuperConvert displays a dialog
box that lets you adjust the size and position of the printed image:

(

loliDIBIIXJol

Ok )

-0@Top

(Cancel)
(

Ocenter

Info... )

OBottom
[8] Addcaption

( Setcaptionfont)

0 CenterO Right

I"BigGoriIJo»
Print Enhanc ed dialog box
As you chan ge the options, the graphic representation shows the size of

the resulting image in green, and indicates how many pieces of paper will
be used for the printing. The numb ers represe nt the page number; if the
paper jams or you have other printing prob lems, you can refer to these
numb ers to dete rmine where to continue pr inting.
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The scroll bars are used to expand or shrink the image, and the Top,
Center, and Bottom options are used to position the image on the
printout.

I

J

To add a caption at the bottom of the page: Type the text for the caption
then click Set Caption Font to choose the font and size for the caption
(this also automatically checks the "Add Caption" checkbox).

1

After setting these options, click OK to present the "Print" dialog box for
the chosen printer. Select the number of copies, page range, quality, and
so on (actual choices depend upon which printer driver you are using).
After setting these options, click OK to begin printing.

1·
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Print Alignment Page

I
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Choose Print Alignment Page from the File menu to Print a test page with
an L-shaped mark at each corner of the printable area. The size of the
printable area depends upon the options you select in the "Page Setup"
dialog box. For example, checking a "No gaps between pages" option (if
available) gives a larger printable area. NOTE: 1be actual print options
depend upon the chosen printer driver.

If a printed image will be more than a single page wide, you can print an
alignment page to help adjust the paper feed so that the right or left
alignment marks are printed exactly on the edge of the paper (you cannot
adjust the paper feed position on some printers, such as the LaserWriter).
With the paper feed in that position you can easily tape the printed pages
together to form the complete image. If you do not adjust the paper feed,
you will have to cut one side of the paper off before you can tape the
pages together.
After printing, this command can be used again to help return the paper
feed so the alignment marks are centered on the paper.
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Examine File
Choose Examine File from the File menu to examine the contents of any
file. The standard file selection dialog lets you choose which file(s) to
examine. Multiple files can be se lected: Hold down the Shift key when
clicking to se lect ranges of files, and hold down the O key to selec t
individual files .
After se lecting the file(s) to examine, click Accept to examine the first one.
For each file you hav e up to thr ee options for how you want to view it:
the data fork (the norm al part of a file that is pre sent in most files), a
histogram (spectrum analysis) of the data fork, or the reso urce fork
(ge nera lly present only in new er program files). When you are done with
each file, click the window's close box to go on to the next file or return
to normal program operation.
■

@Dot fork

O Histogram

()Resourcefork

000000 00 00 00 00 01 11 07 76 00 00 06 43 07 65 05 32 ?@@@AQGll?@F
CGeE2{r
000010 06 54 05 43 04 32 06 55 05 54 04 43 04 33 03 21 FHCD2FUETOC03C!
000020 01 22 06 65 20 20 20 20 20 20 20 20 2E20 20 20 A"fe
.
000030 80 1E00 00 00 00 41 4E 76 69 73 69 6f 6E41 01 l"ff;f!~AHvi
si onAR
000040 ff FFFC00 00 FC28 BE00 FC28 32 00 FC00 02 B @
l(l:ll(2@1)8
000050 9C00 96 f4 00 00 00 02 CA04 00 01 75 70 00 02 llllll?@@B
IO@A
up@B
000060 00 01 00 02 00 02 CA18 00 01 7C88 00 04 CA10 ?OOB@BIX?A
lll!lOI?
000070 00 08 00 00 00 27 00 07 00 02 CA2E00 01 fl f C @H@€!@
' ~G?BUAII
oooo
so oooooooooooooo00 oooooooooooooooo ?~?@@@?~~?OOf;
000090 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 (iJQ~~@~~~~S@i,~
OOOOAO
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 t~@f;@~~iii~f;~~t
000000 oooooooooooooooooooooooooooooooo @~~?m~l®~?m
.
ooooco00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
000000 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
OOOOEO
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 f@€.f~@W'P@~f;
OO
OF
OO 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 @OO~?@~@~if?~f
000100 oooo00 00 00 00 00 00 00 00 00 00 00 00 00 ooI ?@@f:@~~?@@f;@~§
-0
7be Examine File window's Data and Resource Fork display

Data and reso ur ce forks are viewed in a scro lling wind ow with side-byside hexadec imal and ASCII text repre sentations. The ASCII text sect ion is
colo r coded as follows:
Norma l ASCII characters ($00 ... $7F): Backgro und is white
High ASCII characters ($80 ... $FF): Backgroun d is green
Contro l characters ($00 ... $1F, $80 ...$9F): Text is pu rple
Printab le cha racters ($20 ... $7F, $AO... $FF): Tex t is black
The De lete character (norma l $7F, high ASCII $FF) is show n as a
triangle.
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Tbe Examine File window's Histogram display
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The histogram display is a bar graph showing the number of times each of
the 256 possible byte values appears in the file. Pointing to a bar shows
what byte value the bar represents, its exact number of occurrences in the
file, and its percentage of the file .
This feature is intended to help identify files of completely unknown
format.. .many formats have a distinct distribution of byte values. For
example , IBM .PCX graphi cs files almost always have their highest peak at
byte $Cl , with the next few sequentia l bytes also having relatively tall
bars. NOTE: Tbe exact interpretation of the results depends on the format
of each file, and is beyond the scope of this documentation.

Quit
Shortcut: OQ

·1

Choose Quit from the File menu to exit SuperConvert and return to the
program launcher. No warning is given if you try to quit before saving, so
be sure you have saved your most recent convers ion if you intend to keep
it

7

Menus: File Menu

81

Edit Menu
The commands in the Edit menu are only enabled when a New Desk
Accessory (NDA) is the frontmost window on the screen.

Close
Choose Close from the Edit menu to close an active NDA window.

r .

,. .

r .
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Screen Image Menu
This menu is enabled after an image is loaded. These commands operate
only on the current screen image; they do not affect or use the true color
image in any way .

View Full Screen
Shortcut: OF
Choose View Full Screen from the Screen Image menu to display the full
screen view of the current screen image. If the image is larger than the
screen, it will automatically scroll to show you all parts of the image. You
also can use the mouse to scroll the full screen image.
Press any key or the mouse button to exit. NOTE: lf you press a valid 0
key command shortcut, the command will be executed immediately.
If you have an Apple Vjdeo Overlay Card and have checked the "Use
second monitor" preference, the full screen image will "stick" on the
monitor connected to the VOC, while normal program operation continues
on the monitor attached to the back of the IlGS.

View Half Size
Shortcut: OH
Choose View Half Size from the Screen Image menu to display the current
screen image a t half actual size.
This allows the largest image
SuperConvert can handle to fit entirely on the screen. TECHNICALNOTE:
The hyperbolic curve at the lower right of the screen represents the 64K
image size limitation-no image's lower right corner can extend into that
area.
Press any key or the mouse button to exit. NOTE: lf you press a valid 0
key command shortcut, the command will be executed immediately.
If you have an Apple Video Overlay Card and have checked the "Use
sec ond monitor " preferenc e, the half size image will "stick" on the monitor
conn e cted to the VOC, while norm al program operation continue s on the
monitor attached to the ba ck of the IlGS.
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View X4 Magnified
Shortcut: 04
Choose View X4 Magnified from the Screen Image menu to display the
current screen image magnified four times, allowing you to see details you
couldn't at actual size. Moving the mouse scrolls the image on the screen.
Press any key or the mou se button to exit. NOTE: If you press a valid 0
key command shortcut, the command will be executed immediately.
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Image Info
Shortcut: OI
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Choose Imag e Info from the Screen Image menu to calculate statistics on
pixel and palette usage within the current screen image. NOTE: This
command is different from the Image Info command on th e True Color
Image menu, which generates similar statistics for the curren t true color
image.
:SuperConvert
:Sanples:Big
.6oril lo.HEO
II Color Palette
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Screen Image's Image Info dialog box
The results are not very meaningful for multipalette images because pixels
w ith the sa me color number, but in differe nt palettes, w ill be added
together regardless of w hether they represent the same color. To ge t an
accurate count of the colors in a multipalette image, choose Discard True
Color Image from the True Color Im age men u (if e nabl ed) then choose
Image Info from the True Color Image menu.

l
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Crop To Clipping Area
Choose Crop To Clipping Area from the Screen Image menu to discard all
but the selected area of the screen image. N01E: You cannot Undo this
command; if you think you'll need the complete image later, first save the
full image to disk, then crop it.
This option is available only if an area of the screen image has been
selected.
To select a portion of the screen image, click in the screen
image window to activate it, then drag the mouse to create a selection
rectangle. You can resize the selection rectangle without starting over by
holding down the Option key when you click in the w indow (this lets you
reposition the corner closest to the pointer).
If you just want to save the selected

area you do not need to use this
command. However, to work with just the selected are a in any other way
(print, get info on the selected area, etc.) you must use this command first

Store Palette
Choose Store Palette from the Screen Image menu to remember the palette
of the current screen image for use in future Remap operations. This is
stored in memory only; the pal ette will be gone the next time you run the
program. N01E: For multipalette images, only palette #0 is stored.
This feature allows you to convert pictures so that they use the exact same
pal e tte as some existing picture. This is especially useful for the following
situations:
•
If you want to remap images for use with a program that requires a
particular palette, but that palette isn't directly supported with the
Remap Image command. For this situation, load a sample image that
has the palette you need to use, choose Store Palette, then use the
stored palette when remapping other images.
•
If you are converting animation frames from other compute rs for use
with an animation program on the IIGS. Animations generally look
smoother if all the frames use the same palette, so it's best if you
remap each frame to use the same palette. For this situation, load a
"typical" animation frame (one that includes as many of the colors
used throughout the animation as poss ible), choose Store Palette, then
use the stored palette when remapping the remaining animation
frames.
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Use As DesktopBackground
Choose Use As Desktop Background from the Screen Image menu to
replace the desktop background with the current screen image. If the
current screen image is larger than the screen, the bottom is chopped off;
if it is smaller, it is centered on the screen and the area around it is made
light blue.

J
J

The new background will appear in most desktop programs, and lasts
until a different background is specified, the Revert To Normal Desktop
command is given, or the machine is shut down. NOTE: See the
description of the Desktop Background !NIT save format if you want the
special background to be permanent.
Any screen image can be used as the desktop background, but the image
won't look right unless the palette of the program matches the palette of
the original image.
You can use the Remap Image command to convert an image to a
different palette or mode . For example, most 640 mod e programs use the
default color palette, so try remapping the original image to "640 x 200
dither mode with the default color palette."
TIP: To make the image appear correctly in all screen display modes you
can remap it to "320 x 200, 16 color mode with a Black and White only
palette." Of course, this probably will not match the original picture's
quality.

OscilloscopeArt
Choose Oscilloscope Art from the Screen Image menu to view the screen
image on a standard oscilloscope connected to the IIGS's composite video
output jack. Choosing this command replaces the current screen image
with an image that will display on an oscilloscope.
The effective
resolution of the display is 320 by 100 with 3 gray levels. NOTE: There is
no known reason why anyone would want to do this, but Jason thought it
would be cool. If you find a use for this feature, please let us know!

RequiredSettings
Set the followin g display opt ions in the Control
Monochrome, Border-Black.

Panel :

Type-

Set the following oscilloscope settings: DC-coupled input, 1V Line sync if
available, about 0.5 volts/d iv vertica l sensi tivity, about 20 msec/div
horizontal sweep, adjust trigger level for a stable image.

1
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True Color Image Menu
This menu is enabled on ly if an image is in memory. Commands on this
menu are used to generate new screen images and operate on the current
true color image.
A true color image cannot be displayed directly on the IIGS screen
because it can contain thousands of colors, and the resolution is limited
on ly by available memory.
A true color image is produced in one of two ways:
• By loa ding a true color image (graphics that load as a true color image
are indicated by an asterisk to the left of the Load Format name).
• By choosing a command from the True Color Image when no true
colo r image is in memory (a true color image will automatically be
created from the current screen image).

Remap Image
Shortcut: OM
Remapping is the process of converting a true color image into a screen
image that the IIGS can display directly.
This command is done
automatically whenever a true color image is loaded. Remapping an
image produces a new screen image; it does not affect the true co lor
image. Because the true color image remains constant, you can remap as
many time s as you need without having to reload the original file.
The Remap Image command is a very important and powerful feature. It
is used to convert existing images into a format that is best for a particu lar
program.
For example, AppleWorks GS is a 640 mode program that
normally uses the standard color palette. If you load a 320 mode graphic
that uses an odd color palette into App leWorks GS, the resu lts will not be
what you expect. By using the Remap Image command, you can convert
the 320 mode, odd palette graphic into a 640 mode graph ic with a
standard color pale tte that will look better in AppleWorks GS.

NOTE: Graphic Writer Ill is also a 640 mode program, but its import
"translators" automatically convert the g raphi c you're loading into a 640
mode graphic that uses the default color palette. However, additional
quality can be gained by using SuperConvert to pre -process some graphics.
See Appendix A for tips on converting graphics for use with Graphic Writer Ill.
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The Remap Image dialog box contains many options, but it's actually quite
simple to use:

Graphic
■ode
( Infoontheseoptions ) Otheroptions
@320 x200,16colors
121
Integralscalingonly
O 640x 200,4 colors Distinctcolorsused: 16 121
ClipHoriz.beforeVert.
O 640x 200dithermode Distribution:full color D Clipto onescreen
0 Huitipolette 11odes
Palette t1 use
Verticalscaling:from200to 200(1:1)
0 Defaultcolor
Horizontal:
from320to 320(1:1)
0Grouscole
@Colculoted
0 Storedpolette
0 Picture'scurrent
() ( Getother... )
( Cancel)
Renderin1
algorith■
( Quick
rmp)
0 Closestmatch
@Pattern dither
( Normal
reaap)
()Error diffusion
Remap Image dialog box
There are three ways to exit the Remap options dialog box:
• Click Cancel to return to normal program ope rat ion with the existing
true color image and screen image (if there was one) intact. If there
wasn't a screen image, one will be created that just contains a
message indicating that there isn't a real screen image availab le at the
moment
• Click Quick Remap to get a quick preview of an image to help you
determine what options to se lect for a normal remap. Quick remap
takes only a few seconds, but completely ignores all the options
described below and is limited to a single screen image. See "View
Approximation" for another way to preview images.
• Click Normal Remap to produce a screen image from the true color
image using all of the remap options described below. A normal
remap can take several minutes to complete (the progress of the
remapp ing process is displayed and you can stop the process by
pressing OPeriod) .
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Graphic Mode
This area is used to select the IIGS graphic mode to be used by the
resulting screen image. If the image is going to be used in another
program, you should select the same mode here that the other program
uses.
320 x 200, 16 Colors

Compatible with general purpose paint programs, gives good results with
many-colored images.
640 x 200, 4 Colors

Results are generally not the best, except for grayscale conversions and
images that don't have more than four colors.
Compatible with
DeluxePaint in 640 mode.

f

640 x 200 Dither Mode

A unique feature of the IIGS that gives alternatin g columns of pixels a
separate four-color palette, allowing a wider rang e of colors while still
giving high resolution.
Compatible with programs su ch as AppleWorks GS, GraphicWriter III, HyperCard IIGS, and HyperStudio.
Multipalette Modes

Uses the !IGS's ability to assign different palettes to eac h row of pixels.
Up to 16 palettes can be used, makin g it theoretically possible to have 256
colo rs on the screen. Compatibility of multipal ette pictures is extremely
limited, but for programs that do supp ort multipal ette image s this option
gives the best results for images that contain many more colors than the
ITGScan normally display .

Palette To Use
Some programs requi re a specific palette for pictures. In other cases, you
may wish to use a special palett e to achieve a certain effect. The palette
options available here depend on the se lecte d graphics mode.
Default Color

Uses the sta ndard color palette for the se lected mode. This is usua lly the
opt ion you want for programs that use a fixed palette, such as Graph icWriter III and Hyper Studio. Not a good choice, otherwise, because the
default palette may not have a good match for some colors in the image.
Not available in multipalette modes.
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Grayscale

Uses a palette consisting entirely of shades of gray. Good if the image is
going to be printed on a non-color printer, or is known to consist only of
shades of gray. Not available in multipalette modes.

II

Calculated

Generates a palette that best represents the colors used in the image. The
program insures that black and white are at their usual positions at each
end of the palette, and sorts the other colors in increasing order of
brightness.

II

ll

If you don't need a specific palette, this option gives the best color results.
If the image is grayscale or black & white (this will be indicated at the top

center of the Remap options dialog after a few seconds), you should select
Grayscale palette instead, and use the Error Diffusion option described
later.
Stored Palette

Allows remapping to a specific palette. First load a picture containing the
desired pa lette, chose Store Palette from the Screen Image menu, then you
can remap images using this option.
This option is available only when remapping to the same graphic mode
(e.g., if you store a 320 mode palette, it wi ll be available only when
re mapping to 320 mod e).
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Picture's Current

Uses the palette of the most recently loaded, remapped, or otherwise
generated screen image . This option is available on ly in the graphics
mod e that was used by that image.
This option is useful if you are using a True Color Image menu command
to achieve some effect, such as scaling or rotation of a screen image, in
which case the original palette will be a good choice for the new image.
Get Other

Presents a dialog box containing various specia lized palettes that may be
usefu l. The list is different for each grap hics mode, and your most recent
choice is remembered separate ly for each mode so you don't have to
reselect it eac h time you remap .
If the multipalette graphic mode is se lected, these opt ion s control the

technique used to generate the palettes rathe r than specify ing a particular
palette. NOTE: Some of these techniques are still experimental and may

not perform very well.
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Rendering Algorithm
Determines the method used to select the colors of pixels in the remapped
screen image. These options have no effect on the compatibility of the
produced image, but they may have a great effect on quality and
suitability for special uses. The available options depend on the selected
graphics mode and palett e.

r

Closest Match

For each pixel to be produced, this option selects the single, closest color
match from the palette. This is the only option that some conversio n
programs provide . The results aren't good if the original image contains
many colors, since multiple origina l colors will become the same color on
the screen and therefore be indistinguishable.
This option is useful if you kn ow that all colors will hav e an exact,
individual mat ch (for example, if you just flipped or rotated an image and
are using Picture's Current palette opt ion), and in some cases with images
scaled down to a very small size.
Pattern Dither

For each color in the image being remapped, this option determines a
pattern of colors from the selected palette which together closely
approximate the original color. This allows many more origina l colors to
be distinguishable than there are colors in the palette. The patterns are
2x2 pixels in 320 mode, 4x2 in the two 640 mode options, and various
sizes in the multipalette options. This is usually the option to choose
un less the Error Diffusion option is available.

[
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Error Diffusion

Error diffusion is a special option that can simulate up to 256 levels of
gray. It is available on ly if you have se lected a grayscale or black and
white palette. It works by calculating the inaccuracy in each pixel chosen,
then adjusting the pixe ls around it to compensate for that inaccuracy.
For examp le , if the color chosen for a particular pixel is too dark because
an exac t match wasn't available, the nearby pixel s will be lightened to
compensate for it.
You should u sually choose error diffusion when available. The one case
w her e you should not se lect this opt ion is for animation sequences
because this technique tends to produce slightly different results in
identical areas of images (du e to different levels of errors being diffused
from non -identica l areas). The se slight changes will slow down th e
an imation, possibly impair quality, and grea tly increase the memory and
disk space requirements of the animation.
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Scaling
Adjusts the size of the screen image to be produced. Scaling is separately
adjustable for the horizontal and vertical directions from a reduction of
1:16 to an enlargement of 4:1. The scaling is adjusted with the use of two
scro ll bars, and is displayed both numerically (original and sca led sizes,
along with their ratio if it can be expressed by small integers) and
graphically (a green rectangle which shows the size of the resulting image
relative to the screen, represented by a purple grid).
If the scaled image is larger than the screen image size limit, the word
"Clipped" appears, and the green rectangle splits into two areas: a thinbordered area which shows how big the image should be, and a thick
bordered area which shows how much of it you will actually get.
See "Other Options" (next section) for ways to adjust the behavior of
scaling and clipping.

Other Options
These checkboxes affect how image clipping and scaling work.
Integral Scaling Only

Normally the scaling scroll bars only allow you to se lect scalings that
correspond to simple integer ratios (e.g., 1:2, 5:3, etc.). If you wish to
scale an image to an exact size that isn't such a ratio, turn this option off.
Clip Horizontal Before Vertical
If the scaled image is larger than one screen in both directions, and is over

the 64K screen image size limit, this option contro ls whether the
horizontal or vertical size is reduced first in order to make it fit within the
limit. There is no effect otherwise.
Clip To One Screen

This option clips the image so it will be no larger than one screen .
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View Approximation
Shortcut: OA

·~

Choose View Approximation from the True Color Image menu to show an
approx imation of the current true color image. The primary use for this
option is to preview what a true color image looks like without taking the
time required to remap the image into IIGS-displayable format.

-~

View Approximation is capable of simulating over 29,000 colors. Because
the red, green, and blue components of the image are split onto separate
lines instead of being mixed together in each pixel, the results are
somewhat dim and the image is highly magnified.

I~

T

Image Info
Shortcut: OT

I

I

Choose Image Info from the True Color Image menu to calculate the
number of colors in the current true color image, and display a color
usage graph. Also shown is a classification of the image as either black &
white , grayscale, or full color. NOTE: This command is different from the
Image Info command on the Screen Image menu, which generates similar
statistics for the current screen image.

'l

Imagesize:320b11
200

Distinctcolors: 81
Distribution:
full color

f

r
(

~

Print )
Done ]

012JqS6789ABCDEF
IHHHSITY
>

True Color Image's Image Info dialog box
TECHNICALNOTE: The color count only distinguishes between colors that
correspond to one of the IIGS's 4,096 displayable colors (internally, up to
32, 768 colors and 256 gray levels are stored).

94

Menus: True Color Image Menu

Ii

]
]'

I]
I ],
I
II
[I

~ I

J'

Rotate/Flip Image
Choose Rotate/Flip Image from the True Color Image menu to rotate or
flip the current true color image.
( {(Rotate) (Rotate)))

lllol

~
(//Twist

J .----..

(VFlipV)

()Flip})

( Twist\\ )

(-c-a-nc-el-)
( Hake
it so )

Rotate/Flip Image dialog box

Images can be flipped along either axis. If the image size is over 800 x
600 only flips are allowed due to memory limitations.
Rotation is done in multiples of 90° and can take as long as several
minutes to complete.
Twisting is a shortcut for rotating and flipping an image. Because twisting
involves rotation , it can take as long as several minutes to complet e.

Menus: True Color ImageMenu
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Histogram Equalization

[

Choose Histogram Equalization from the True Color Image menu to adjust
color values in the current true color image so the number of pixels at
each intensity level are approximately equal. This option usually increases
the contrast of an image, and is intend ed to help fix images that appear
dark or washed out.

[

Often the res ult gives too much contrast, but this is generally an easier
problem to correct in a painting program than the original lack of contrast.
Thi s command works on any image, but works best if the image is
grayscale or is going to be remapped to a grayscale palette.

An image BEFOREHistogram Equalization
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Tbe sam e image AFTERHistogram Equalization

Discard True Color Image
Choose Discard True Color Image from the True Colo r Image menu to
release the memory used by the current true colo r image (ava ilable only if
there is a true color image in memory). The screen image is not affected.
NOTE: I.,ack of a true color image doesn 't mean that you can't use a True
Color Image menu command. ..using a command will generate a true color
image from the current screen image.
A very large amount of memory is required to store a true color image (for
examp le, at two bytes per pixel a 640 x 200 image requ ires 256,000 bytes
of memory to store). This command lets yo u release that memory for
othe r uses suc h as printin g.
It is also usefu l when you have remapped a true color image into a scree n
image, and want to use a True Color Image menu comma nd on the
resulting image rather than on the origina l true colo r image.

1
,.
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Windows Menu
Choose Normal Positions from the Windows menu to place the program's
windows to their starting positions and sizes.

[

8 file [dit Screenimage Truecolorimage WindowsExtras
Loadformats
AppleII f(Jllilu
Apple!!gsspecific
Amiga
Com11odore
64/12B
Macintosh
IBHPC~compatibles
/\ Co11puter
tupe (
Load )
( Infoonformat) SpecifictypeV
Degas
(.PU,.Pl2,.Pl3)
{}
Degas[lite (.PC1,
.PC2,
.PC3)
Heachrome
(.MEO)
Tin11
(.THY)
*Spectrum
512uncompressed
(.SPU)

,.

I

I

'

C-

r

"I

Tbe "normal positions"for the SuperConverl windows
The remaining items (Load Formats, Save Formats, Screen Image) bring
the named window in front of all others, so that you can use it without
having to move other windows out of the way.
Not included on the Windows menu is the Help window (which can be
brought to the front by choosing a help command) and any new desk
accessory windows (which can be brought to the front by choosing the
NDA from the W (Apple) menu).

r
r •
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Extras Menu
This menu contains features that didn't fit anywhere else. Some of them
really don't have anything to do with graphics conversion and might be
removed from future versions.

Available Font List
Choose Available Font List from the Extras menu to generate a graphics
image, up to one page in size, that contains the name and size of the fonts
you have installed in the System/Fonts folder on your startup disk.

If there are more fonts than will fit on a page, the More Available Fonts
command will generate an additional page. A printout of this font list is
handy to have near the computer when you are selecting a font in a word
processor, paint program, and so on.
The fonts are displayed in order of increasing size, and are sorted
alphabetically within each size. Because the list is displayed in the font
itself, fonts such as Cairo (which contain symbols instead of letters) will be
unreadable. See "Font Key Chart" for information on getting a printout of
symbol fonts.

NOTE: The result of this command is a graphics image. Therefore, when
printing the result you might not want to select the "better text" option that
some print dialog boxes have (because it's a graphics image, "better text"
may actually make the printout look worse).

More Available Fonts
Choose More Available Fonts to continue the process started by Available
Font List. Several repetitions may be needed if you have many fonts
installed. This command is available only if the last Available Font List or
More Available Fonts command did not finish displaying all of your
installed fonts.

NOTE: The result of this command is a graphics image. Therefore, when
printing the result you might not want to select the "better text" option that
some print dialog boxes have (because it's a graphics image, "better text"
may actually make the printout look worse).

Menus: Extras Menu
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Font Key Chart
Choose Font Key Chart from the Extras menu to generate a graphic image
showing all characters of a particular font, size, and style along with their
hex value and key equivalent.

I

After selecting the font, size, and style you wish to display, SuperC onvert
generates the graphic image. The result is limited to one page, so you
may need to use a font size smaller than the desired size in order to fit all
the characters onto the page. If you pick a size that doesn't exist, a size
that is exactly half or double an existing size is better than a random size.
Each character is displayed in the following format:
Hexadeci mal Value
Key Equivalent
(•=Option Key)

~

~[I]

~~

ll

~ Character

The hexadecimal value is mainly of use to programmers.
The key eq uivalent shows what keys are used to produce that character
from within an appl ication. The Option key is represented by the It
symbol. Entry of key equivalents must be exact-if it shows an "A", an "a"
won't work! NOTE: The equivalents are only valid if you have the key
translation set to Standard in the Alphabet section of the Control Panel
NDA.

NOTE: The result of this command is a graphics image. Therefore, when
printing the result you might not want to select the "better text" option that
some print dialog boxes have (because it's a graphics image, "better text"
may actually make the printout look worse).
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Print Banner
Choose Print Banner from the Extras menu to generate a banner with one
or two lines of text in any installed JIGS font , size, and style . NOTE: The
banner is produced by drawing very large characters using standard JIGS
fonts. Unless you have huge font siz es available, the printed result will be
poor compared to progra ms that were sp ecifically written to prin t bann ers
(e.g. Print Shop).
First the "Page Setup" dialog box for the chos e n printer is displa yed. In
this dialog box, do not select sideways/w ide/ landscap e printin g becaus e
that is handled automaticall y. Afte r specifying the Page Setup option s, the
Print Banner opti ons are shown:

First oronluline

( Choose
font: ) Times8old56

ISuperConve
rt

[8] Secon
d line

I
( Choose
36
font: ) Times

IGreatGraphicsConversion
Program
Print:
1

®·

0 1ID1[11!]
0

( Preview)

I
(

Cancel )

f uper~onver~

(

Ok

]

1

Great raphies Cqnversion :ogran1
Print Bann er d ialog box
Type the first and second lines for the bann er. A diffe re nt font ca n be
chosen for each line. You' ll generall y wa nt to se lec t the largest available
size for b est print quality, but if your banner has two lines yo u may wa nt
to cho ose a font of anoth e r available size to control the re lative size of the
two lines. If you pick a size that does n't exist, a size that is exactly ha lf or
double an existing size is better than a rand om size.
The Print option determi nes whether the characte rs will be black or gray
(g ray redu ces ribbon wea r).
The Preview option shows how many p ages the ba nn e r requi res, and
sho ws how the two lines (if selec ted) are aligned.
After setting the banner op tions, click OK to disp lay the "Print Job" dialog
bo x for the chosen printe r. If the re is a "No gaps be twee n pages" option,
you must selec t it to not have gaps on the printout. Do not se lect "Draft"
qu ality printing.
Menus: Extras Menu
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Revert To Normal Desktop
Choose Revert To Normal Desktop from the Extras menu to undo the
effect of a Use As Desktop Background command, a desktop background
INIT file saved onto your startup disk, or any other utility which changes
the desktop pattern. This releases up to 32K of memory for program use.

[
[

This command is available only if there is currently a nonstandard desktop
pattern.

System Info Report
Choose System Info Report from the Extras menu to generate a summary
of your system's current state and configuration, including memory usage ,
installed desk accessories/drivers/etc., Control Panel settings, and so on.
The results can be printed, or saved to disk as a text file.
Exact interpretation
of this data is beyond the scope of this
documentation, and requires some knowledg e of JIGS programming.

[

r

If you are reporting an apparent problem with SuperConvert via U.S. or
electroni c mail or by FAX, it would be appreciated if you include a copy
of this report, generated on your computer und er conditions as close to
those that were in effect at the time of the problem as po ssible . This
make s it much easier for us to identify problems that are specific to a
certain hardwar e or software setup.
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Appendix A
Tips and Suggestions
This appendix contains tips and suggestions for using SuperConvert to its
fullest.

]
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Tips and Suggestions A-1

Making Slides
By following the steps be low , you can take virtually any grap hic and have
it made into a color slide (the results work best with 320 mode and true
color g raphi cs; the "dithering" in 640 mode gives a poor result).
To make a slide from a 320 mo de screen image, first save the screen
image to disk. You can use a hardware device, such as a FingerPrint GS
pr inter card, to freeze a sc reen and save it to disk. There are also public
doma in, shar eware, and comme rcial programs available to save a screen
image.
1. Use SuperCo nvert to load the graphic you wan t to make into a
slide.
2. If you load a true colo r image the Remap Image dialo g box will
appear. If this occu rs, se t the remap options to 320 graphics
mode, calcu lated palette graphic, using pattern dither algorithm,
then click Normal Remap.
3. Select the TIFF (Tagged Image File Forma t) Save Format and click
Save.
4. Specify the size of the grap hic. To ensure you get just a single
IIGS scree n , click the "One scree n wide, one scree n (200) high"
button.
5. Type a name and set the disk locatio n to save the graphic , then
click Save.
6. Set th e TIFF Save opt ions ("Screen image only," "Motorola byte
order ing," and "Increase compatib ility") and click Save. NOTE: If
the "True color image only" option is availab le, selecting that might
produce better color results.
7. Transfer this file to the Macintosh and change the file's "Type" to
"TIFF" and the "Creator" to "????"
.

·r

T

T
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8.

Contact any Macintosh slide service company to have the "color
TIFF" file printed on a slide imager.
Many slide imaging
companies advertise in Macintosh and IBM magazines.
The slide imaging company that helped us test this feature is:
Slidelmagers
Attn: Tony Casadonte
22 Seventh Street
Atlanta, GA 30308
1-800-232-5411 or 1-404-873-5353
FAX 1-404-873-1517
They were very cooperative, and after working with us they won't
be thoroughly confused if you mention "Apple ITGS." In fact, if
you use Slidelmagers you can skip step #7 entirely! Just save the
TIFF files onto a blank IIGS disk (so it only contains the files you
want printed) and clearly mark the disk "IIGS format."
For approximately $6 per image they will transfer the files to the
Macintosh, fix the Type and Creator, produce the color slides, and
return them to you! NOTE: Contact them before sending any disks
to get current pricing, payment methods, and other infonnation.
Slidelmagers also has the ability to make color transparencies and
color printouts from these files-contact
them for further
information.

Tips and Suggestions: Making Slides
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Converting Graphics for GraphicWriter Ill
GraphicWriter III has the unique ability to handle graphics with 72 linesper-inch vertical resolution, while other programs only handle 36 linesper -inch ima ges. Usually when you import a graphic into GraphicWriter III, each line of the graphi c is autom atically repeate d. This method
of doubling the vertical resolution doe sn' t incr e ase the quality of the
image .. .it just "stretches" the graphic so it will be the same size it was in
the original program.
By using SuperC onve rt to "pre-str etc h " an image, you can get a better
quality image for imp orti ng into GraphicWriter III (where GW III simply
d ou bles eac h line, SuperConvert does some fancy calculations to make
each line "significa nt " in the stretched graphic). NOTE: The method
described below is ben eficial for true color and 320 mode images. 640
mod e and MacPaint images should be imp orted directly into GraphicWriter III for best results.
After pr e-stretc hing and saving the graphic with SuperConvert, you import
the new graphic into GraphicWriter III just like you import the clip art that
was suppli ed with GW III (use the Super Hires translator and be sure to
che ck the "Half He igh t" option).
The exac t steps for do ing this conversion:
1. Load the or iginal graph ic with SuperConvert. Keep in mind that
320 mode and true color images work best (there is no noticeab le
difference for 640 mode graphics, and the MacPaint translator
works better for importing MacPaint grap hics).
2. Choose Rema p Image from the True Color Image men u, then set
the following options:
Graphic mode : Select 640 x 200 dither mode
Palette to use: To produce a color image selec t Default Color; to
produce a pseudo -graysca le picture in GW III select Grayscale, or
to produce a black and wh ite image click Get Other and select
Black and White only.
Rendering algorithm: Selec t Pattern Dither. If Error Diffusion
can be chosen, se lect it instead .
Steps 1 and 2 app ly equa lly as well to othe r 640 mode pr ograms that use
the defau lt color pa lette (e.g. AppleWorks GS, HyperStudio, and so on) .
The third step is the specia l one that app lies only to Graphi cWrite r III:
3. Use the Vertical Scaling scro ll bar to stretc h the graphic to twice
the or iginal heig ht (vertical sca ling shou Id read "2:l ").
4. Click Normal Remap to create the new image.
A-4
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5. After the remap is done , select the "$C0,2 Apple Preferred" Save
Format and click Save.
The largest size GraphicWriter can handle in a single painting
frame is 640 x 400. If the new graphic is larger than 640 x 400,
click the "One screen wide, two screens (400) high" button,
otherwise click the "Same as original" button.
Type a name for the graphic, select the disk location to store the
graphic, and click Save.
To import the newly-saved graphic into GraphicWriter III:
1. Start GW III, open a document, and create a painting frame.
2. Choose Import from the File menu, select the Super Hires
translator, then click OK.
3. Click the "Half Height " option.
4. Find and select the newly-saved graphic file.
5. Click·Open to import the graphic.
While this process of using SuperConvert requires more steps than simply
importing a graphic straight into GraphicWriter III, the increased quality is
well worth the extra effort. To compare for yourself, create a second
painting frame and import the original graphic (don 't select Half Height) .
Print the file or choose Tall Text from the View menu to see the
differences between the two graphics.

Tips and Suggestions: Converting Graphics for GW Ill
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Appendix B
Out To Launch
Out To Launch is a simple "program launcher" that is meant to replace the
program-launching function of Apple's Finder, thus saving much disk
space. It can launch applications and it provides access to the New Desk
Accessories on the ti (Apple) menu. This is especially useful with an
NDA such as Disk Access, which provides all the functions of the Finder,
plus other functions such as Find File and Show File.
Out To Launch uses about 7K on disk and in memory, and it requires an
Apple IIGS with at least 512K memory (ROM 01 or higher) and GS/OS. It
should be named Start and placed in the System folder of your startup disk
(it is possible to run it from another launcher, but that would defeat its
purpose).
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Out To Launch
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The Menus
• (Apple) Menu
About Out To Launch-Shows
inform ation.

version number,

credits, and general

File Menu

r
[

Shut Down-Ejects all "ejectable" disks and shows the message "You may
now switch off your Apple IIGS safely." This shut down is configured so
it will not reset RAM disks in case you decide to Restart.

[

Quit-Quits
Out To Launch and returns to the previous program
(presumably another launcher ). If there is no previou s program, then the
System launches Out To Launch again.

r
r

Edit Menu
This menu is provided for desk accessories.

T
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Out To Launch: The Menus

The Command Buttons
Launch Item
Launch Item laun ches the highli ghted ite m, unless it is a "dummy line " (a
line with no application attached-see Add Item ).

Launch Other
Launch Oth e r displays the standard "get file" dialog bo x for you to choo se
a program to launch (only Folde rs, P8 System file s, and GS/ OS
applications are displayed).

Add Item
Add Item displays the standard "get file" d ialog b ox for you to choose an
application to add to the list (on ly Folders, P8 System files, and GS/ OS
appli cations are displa yed).

]

After selecti ng an application, a seco nd dial og box appears to let you
customi ze the name of the appli cation as it appears in the list (th is does
not rename the file). See Edit Item for information.
You can crea te a "dumm y line" for filler o r spacing by holding down the
Opt ion key when you click the Add Item button. Th is skips the file
selection and goes direc tly to the edi ting dialog box.

.,.

Remove Item
Remove Item de letes the highlighte d item from the list.

Edit Item

]

Edit Item ope ns a dialog box to let you edi t the name of the highlighted
item as it appears in the list. You are allowed up to 31 characters o f freeform e ntry (anything you ca n type is accepta ble). The items in the list are
sor ted in asce ndin g ASCII orde r.
The opt iona l code is not d isp layed in the list. It is used if you want to
gro up ite ms toget h er o n the list (for examp le , to group graphic
app lications together you could code eac h app licat ion wit h a "g").
Clicking th e OK button (or pre ssing Return) stores any changes . Clicking
the Cance l button aborts the process .

Out To Launch: The Command Buttons
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Error Handling
Out To Launch requires GS/OS, otherwise a "GS/OS required" message
will be shown.
The startup disk must be available at program startup and shutdown to
load and save your list. If it can't find •;sys tem, then you will be
prompted to insert the System disk.
Any disk error while loading your custom list of applications presents a
message "Problem loading. Error $####" (it is not an error to have no list
at all). It is possible to get a memory error during the load; if so, an "out
of memory" message is shown and the remainder of the load is aborted.
When saving the list, if the disk is write-protected you will get a mes sage
and a chance to try again. Any other disk error presents a message
"Problem saving. Error $####."
The program you are trying to launch is verified to be available, otherwise
you get a "Can't find program" message and a chance to swap disks.

!

If there's not enough

room to add an item you will get an "out of
memory " message, and the item is not added to the list.

r
r
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Out To Launch: Error Handling
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This index attempts to reference all the topics you might look up. If you
are looking for a particular topic and can't find it, please let us know so
we can incorporate it in the next printing of the manual.

"3200 Color" Pictures 45
320 x 200, 16 Color Graphic
Mode 90
640 x 200 Dither Graphic Mode

1

90
640 x 200, 4 Color Graphic Mode

90

Apple Preferred 41, 60

A
About SuperConvert 70

1

Apple IIGS-Specific Load Formats
40
"3200 Color" Pictures 45
AST Picture Data File 44
Finder Icon 44
PaintWorks Gold 43
Print Shop IIGS 43
SuperHiRes 40
Uncompressed Screen 42

Adjusting Contrast 96
Amiga Load Formats 48
IFF 48
App le (ti) Menu 70
Apple II Family Load Formats 38
Double HiRes 38
HiRes 38
Print Shop 38
TDM Text Screen Captures 39

AST Picture Data File 44
Atari ST Load Formats 46
Degas 46
Degas Elite 46
Neochrome 46
Spectrum 512 47
Tiny 47
AutoD es k Animator 52
Available Font List 99

B
Backup Disks 7
Banners 101
Bug Re ports 102

Index

1

[
C
Calculated Palene 23, 91
Cancel Remaining Files 76
CDAs 74

Commodore 64/128 Load
Formats 49
Doodle 49
Koala Illustrator 49
Print Shop 49

Clear 82

Computer-Independent Load
Formats 53
Graphics Interchange Format
(GIF) 53
IPI Image 54
Quick Ray Tracer (QRT) 55
Run Length Encoded (RLE) 54

Click (mouse) 4

Context -Sensitive Help 72

Clip Horizontal Before Vertical

Contrast 96

Check Startup Device 8, 17
Choose Printer 74
Classic Desk Accessories 74

93
Clip To One Screen 93
Close 82
Closest Match Rendering
Algorithm 92
Command Keys 69
0 - (Preferences) 73
0 -Control-Esc 74
0/ (Help) 71
04 (View X4 Magnified) 84
O? (He lp) 71
(Preferences) 73
OA (View Approximation) 94
OF (View Full Screen) 83
OH (View Half Size) 83
OI (Screen Image Info) 85
OL (Load & Convert) 75
O M (Remap Image) 88
ON (Load Next) 76
OP (Print Enhanced) 78
OQ (Quit) 81
OR (Re-convert Last File) 75
O S (Save Conversion) 76
OT (True Color Image Info)
94
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Contro l Panel 5, 74
Copy 82
Copy Protection 7

[

Copying Disks 10
Copyright 7
Crop To Clipping Area 86

(

Customizing SuperConvert 73

l,

Cut82

D
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Data Fork 80
DC Printe r 74
Default Color Palette 22, 90
Degas 46
Degas Elite 46
DeluxePaint II 52
Desk Accessories 14, 74
Desktop Background Image INIT
64
Discard True Color Image 97
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Disk Access 11
Disk Initializer 8, 74

GraphicWriter
Appendix A

Dithering 22

JI

Doodle 49

Format

III Conversions

Grayscale Palette 24, 91

Double HiRes 38
Double-Click (mouse) 4
Downloading

Graphics Interchange
(GIF) 53, 65

GS/OS 3
Guided Tour Section 15

Notes 50, 54

H

Drag (mouse) 4

E

~

Edit Menu 82

~ 11

Examine File 80

He lp 71, 72
HiRes 38
Histogram 81

Error Diffusion Rendering
Algorithm 92

Exchange Load/Save Paths 76

Histogram Equa lizati on 96

IB~l PC & Compatible Load
Formats 52
AutoDesk Animator 52
DeluxePaint II 52
PC Paintbrush 52

i 11

Extras Menu 99

I 11
i 11

File Menu 75

IFF 48

Finder Icon 44, 62

Im age Info 85, 94

Flip Image 95

Instructions 3

Font Key Chart 100

Integral Scaling Only 93

Fonts 99, 100

!Pl Image 54
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Format Descriptions 37, 57

G

K
Keyboard 3

Get Other Palette 24, 91

Keys 3

Ge tting Help 71, 72

Koal a Illustrator 49

Getting Started Sectio n 1
GIF (Graphics Interchange
Format) 53, 65
Graphic ~lode 20, 90

Index
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L
Load & Convert 19, 26, 75

NDAs 6, 74

Load Formats 35
Amiga 48
Apple II Family 38
Apple IIGS-Specific 40
Atari ST 46
Commodore 64/128 49
Computer-Independent 53
IBM PC & Compatible 52
Macintosh 50

Neochrome 46
New Desk Accessories 6, 74

M
Macintosh Load Formats 50
MacPaint 50, 51
ScreenMaker 51

Norma l Remap 23, 27, 89

0
Open-Apple Keys See Command

[

Other Settings 6
Out To Launch 8, 17, Appendix
B

p

Making Slides Appendix A

PackByte s 40, 59

Memory 6, 71, 97

PaintWorks Gold 43

Menu Item He lp 72

PaintWork s Plus 40, 58

Menus 69
Appl e 70
Edit 82
Extras 99
File 75
Screen Image 83
True Color Image 88
Window 98

Palette To Use 90

Picture's Current Pale tte 91

More Available Fonts 99

Preferences 73

Mouse 4, 5

Press (mou se) 4

Paste 82
Pattern Dither Rendering
Algorithm 22, 92
PC Paintbrush 52
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Oscilloscope Art 87

MacPaint 50, 51

Multipalette Graphic Mode 90

[

Norma l Positions 98

Keys

Load Next 76

[
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Print 3
Enhanced 78
Normal 77

Quick Remap 27, 89
Quit 81

Scaling 93

Print Banner 101
Print Shop 38, 49
Print Shop IIGS 43

Q
QRT (Quick Ray Tracer) 55
Quick Keys See Command Keys
Quick Ray Tracer (QRT) 55
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Save Conversion 25, 76
Save Formats 57
Apple Preferred 60
Desktop Background Image
INIT 64
Finde r Icon 62
GIF (Graphics Interchange
Format) 65
Graphics Interchange Format
(GIF) 65
PackBytes 59
PaintWorks Plus 58
Tagged Image File Format
(TIFF) 66
Uncompressed Screen 61

Print Alignment Page 79

I
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Screen Imag e 19, 67

RA.1\1
Disk 6

Screen Image Menu 83

Re-convert Last File 75

ScreenMaker 51

Reference Section 33

Shortcuts See Command Keys

Remap Image 21, 88

Slot Four 5

Rendering Algorithm 22, 92

Slot Settings 5

Requirements 3

Spectrum 512 47

Resource Fork 80

Starting SuperCo nvert 17

Revert To Normal Desktop 102

Startup Device 8, 17

RLE (Run Length Encoded) 54

Startup Slot 5

Rotate Image 95

Steps 3

Rotate/ Flip Image 95

Store Palette 86

Run Length Encoded (RLE) 54

Stored Palette 91
Suggestions Appendix A
SuperConvert 70
Supe rHiRes 40
System Info Repo rt 102

Index

5

r
T
Tagged Image File Format (TIFF)

66
TDM Text Screen Captures 39
TIFF (Tagged Image File Format)

66
Tiny 47

r
r
r

Tips and Suggestions Appendix A

Transfer Notes 36, 50, 54
True Color Image 26
True Color Image Menu 88

u
Uncompressed

Screen 42, 61

Undo 82

r
r
T

Use As Desktop Background 87

T

V
Version Number 18
Video Overlay Card (VOC) 73
View Approximation

27, 94

View Full Screen 20, 83
View Half Size 20, 83
View X4 Magnified 20, 84

voe

(Video Overlay Card) 73

w
Windows Menu 98
Working Copy 7

T
6

Index

.Jl

J
, .J.

IJ

I
l
lj
IJ
1
fl ]

J
II

!I ~.
l _

J

_J

~

~:,~;;:z~

[

SuperConvert
"SuperConvert is so incredibly flexible (and
easy to use) that it can convert virtually any
type of graphics file to super hl -res."
-inCider

/ A+

Sup erConvert ™ is the link betwee n yo ur IIGs and virt ually any graphi c!
Thi s progra m co nverts fo rmats from Apple II, Macintos h , IBM, Atari ST, Amiga,
Commodo re 64/ 128, a nd eve n comp u ter-inde pende nt form ats such as GIF,
to form ats th at are usabl e on yo ur App le IIGs.
It's easy to use. J ust transfer the des ired grap hic on to a Iles dis k, via mo dem
o r oth er mean s, then co nvert it to su pe r hi-res with SuperConvert. Converted
images ca n be p rinted d irectly w ith Sup erConvert w ith a variety o f o ptions,
incl ud ing the ab ility to pri nt wa ll-size p osters!
But Sup erCo nve rt is no t just :or co nve rting formats from ot her co mp uters! Use
its p owe rful "Remap Image" co mmand to eas ily co nvert a 320 mode image so
it appea rs co rrec tly in 640 no de prog rams. Or change a color image into a
g raysca le or b lac k and w hite picture .
Supe rConve rt ca n be use d to prod uce co lo r slides fro m any 320 mode grap h ic.
This fea tu re is per fect for tea ch ers' classroom mate rials, game players '
auth entica tio n, an d any o ne who wa nts crystal-clea r screen shots .
It eve n ge nera tes "font sa mple" pages, "font key " charts and can make any
image app ea r as your "d eskto p backgrou nd ."
Use Su pe rCo nve rt for all your graphi cs co nve rsio n needs!

Sugg e.i:tecl reta il is o n ly $39.9 5
Req uires : Appl e Iles w i:h 1MB RAM and at leas t o ne 3.5'' disk dr ive
Also inclu des : GS/OS, Out To Launc h , and Disk Initialize r
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